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About this manual

1 About this manual

This manual describes the setup, the functions and use of the system and helps you to commis-
sion the system with MODBUS TCP.

Read this manual carefully before using the system. This will prevent the risk of personal injury
or damage to property or equipment. Keep this manual safe during the service life of the sys-
tem. If the system is passed on, hand over this manual as well.

1.1 Target groups

This manual is designed for use by suitably qualified and trained personnel and must be read
and followed by anyone entrusted with any of the following tasks:

Unpacking and mounting

Commissioning

Setting

Testing and maintenance

Troubleshooting

Disassembly and disposal

1.2 Explanation of symbols

Warnings related to actions are placed in front of potentially dangerous operating steps and
are indicated with graphical symbols. Each warning is introduced with a warning symbol and a
keyword expressing the severity of the danger. The instructions must be observed in all cases:

DANGER
DANGER indicates an immediate hazardous situation, which, if not avoided, will result
in death or serious injury.

> P

WARNING
WARNING indicates a possible hazardous situation with the risk of death or serious
injury if it is not prevented.

NOTICE
NOTICE indicates a situation that may cause possible damage to property if it is not
prevented.

= =

NOTE

NOTE indicates tips, recommendations and important information. The notes simplify
work, contain information on particular operating steps and help to avoid additional
work resulting from incorrect procedures.

\

§

MANDATORY ACTION
This symbol denotes actions that the user must carry out.

RESULT OF ACTION
This symbol denotes the relevant results of actions and procedures.
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Other documents

1.3 Other documents

Besides this document the following material can be found in the Turck product database at
www.turck.com:

Engineering manual

Startup manuals

Product specific data sheets

Device approvals
The free Turck BL ident® simulator for optimizing and simulating an application is available at
http://www.turck.com,

1.4 Naming convention

Common synonyms for “tags” are “data carriers’, “transponders” and “mobile data memory"”.
Read/write heads are also called “transceivers’.

1.5  Feedback about these instructions
We make every effort to ensure that these instructions are as informative and as clear as pos-

sible. If you have any suggestions for improving the design or if some information is missing in
the document, please send your suggestions to techdoc@turck.com.

2015/11
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About the system

2 About the system

BL ident® is a modular RFID system for use in industrial environments. The system allows HF
technology (13.56 MHz) and UHF technology (865...928 MHz) to be run in parallel. The system
consists of several components and levels that can be flexibly combined:

Interfaces

The interfaces consist of a gateway for connecting to a network and RFID 1/0 modules for

connecting the read/write heads. The BL67 (field mounting) and BL20 (control cabinet

mounting) modular I/0 systems and the BL compact fieldbus modules (field mounting) pro-

vide the basic system.

Read/write heads for the HF and UHF range

Tags for the HF and UHF range

Connection cables

Handhelds for the mobile writing and reading of data (optional)

2.1 System identification
2.1.1  BLident®interface - type code
Modular interface sets in IP20 and IP67

Type code - example

T I -|BL67|- |PG|-|DP|-[s]|-|2]
Type code - explanation
T | Interface set ‘ - l BL67‘ Modular I/0 system ‘ - | PG ‘ Programmable gateway ‘ - ‘
| Device Type |—— Modular I/0 system Programmable gateway
I Interface set: BL20 cabinet mounting (IP20) PG Programmable gateway
gateway and RFID modules BL20-E cabinet mounting (IP20)
ECONOMY version
H ®
TURCK RFID system BL ident BL67 field application (IP67)
‘ DP ‘ Fieldbus ‘ - [S] Communication ‘ -12 ‘ Number of channels
Fieldbus Communication l— Number of channels
co CANopen blank data transfer via function block 2 2channels for 2 read/write heads
DN DeviceNet™ (PIB) in the Ck?lntEBOItumt or 4 4 channels for 4 read/write heads
DP/DPV1 PROFIBUS-DP S Z::gi?;:f; v?a Ijloeway 6 6 channels for 6 read/write heads
EC EtherCAT® communication 8 8 channels for 8 read/write heads
EN Modbus TCP?

EN-IP EtherNet/IP™
PN-AC  PROFINET IO + AIDA

T TI-BL67-EN-S-x and TI-BL20-EN-S-x
with multiprotocol: Modbus TCP,
EtherNet/IP™ and PROFINET
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Compact interfaces - BL compact for BL ident®
Type code — example

BLCDP -|2|M12/S | T|- |2RFID-A|- |8DI-PD|

Type code - explanation

System identification

BLCDP Compact|/O system ‘— | 2 |M1 2| S | T ‘ Housing ‘— |2RFID-A ‘ RFID communication ‘— ‘
I— BLC - compact I/O system for Connector for RFID communication
field application (IP67),fieldbus power supply 2RFID-A data transmission
type: T separate via function block
BLCDN DeviceNet™ M12 connector (PIB)
BLCDP PROFIBUS-DP blank no separate 2RFID-S data transmission
BLCCO CANopen connector via I/O
communication
——== Housing size
S small housing
93x71x325

M middle housing
113x71x325

L large housing
168 x 71 x32.5

——————== Connector type

M12  connector
M12x1

M16 connector
M16 x 0.75

1 connector

2 connnectors
4 connnectors
6 connnectors
8 connnectors

= 0 O N =

=)}

16 connnectors

| 8DI-PD | Inputs/Outputs

Inputs/Outputs

8XSG-PD 8 digital inputs/
outputs, configurable,
PNP, diagnostics

8DI-PD 8 digital inputs, PNP,
diagnostics

2015/11

M8 connector M8 x 1

-—————== Number of connectors
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About the system

212
Type - Example:

BL ident® read/write heads — type code

T N LR ... - Q80 -|H1147 - |EX

Type - Description:

T N LR ... Read/write head ‘— | Q80 ‘Housing ‘— “ H1147 ‘Connector type ‘/ ‘
|— Working frequency Housing Connector
blank 13.56 MHz CK40 rectangular 0.15-RS4.47T pigtail (150
865  865...868 MHz 40x ‘é‘l) x 65 mtmt" " mm) Wi:h ”&31';
variable orientation o connector
866  866...868 MHz active face H1147 connector
902 902...928 MHz EM18WD thread M18, stainless steel, M12x1
840/ 840.5...844.5 MHz wash down (IP69K) H1147L connector
920  &920.5...924.5 EM30WD thread M30, stainless steel, M12x 1, lateral
MHz wash down (IP69K)
902/ 902...907,5 MHz & M18 thread M18
915  915...928 MHz M30 thread M30
917 917...920.8
MHz Qo8 rectangular,
32x20x8 mm
. Q14 rectangular
Special range 55.5x 30 x 14 mm
LR long range Q42TWD  rectangular,
SLR  superlong range 68 x 42,5 x 42,5 mm,
active face on top,
Read/write heads, wash down (IP69K)
mounting condition Q80 rectangu]arl
B flush mountable 114 x 80 x 40 mm
N non-flush Q80L400 rectangular,
mountable 400 x 80 x 25 mm
Q80WD rectangular,
TURCK RFID-System 83 x 102 x40 mm,
BL ident® wash down (IP69K)
Q120L130 rectangular,
120 x 130 x 60 mm
Q175L200 rectangular,
175 x 200 x 60 mm
Q175 rectangular,
175 x 200 x 60 mm
Q350 rectangular,
370 x 350 x 20 mm
S32XL ring shaped,

@ Approvals

|— Approvals
Ex approval for Ex-Area

180x 120 x 32 mm
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2.1.3  BLident®tags - type code
Type - Example:

TW .. -/ Q51|-| M |-|HT|-|B128|- EX

Type - Description:

System identification

T W ... Datacarrier ‘ - ‘ Q51 ‘ Housing ‘ - IE Features ‘ - ‘
I— Working frequency I—— Housing |— Features
blank 13.56 MHz BD10X1.5-19 screw housing, C  cheque card format
865-868 865...868 MHz P'aST'CEWO ?91 =% F  foil data carrier
865-928 865...928 MHz wrenc Slze, mm M  for direct mounting on metal
BS10X1.5-19 screw housing, X X
860-960 860...960 MHz metal/ MF for direct mounting on metal,
902-928 902...928 MHz plastic, M10 x 1.5, foil shielded
wrench size 19 mm P paper data carrier
———== Data carrier,memory access BV10X1.5-19 screw housing,
w read/write stainless steel/
R donl plastic, M10 x 1.5,
readonly wrench size 19 mm
l.. inlay & dimensions
TURCK RFID-System BL ident® inay & cimenst
L... label & dimensions
Q...L... rectangular &
diameter
Q51 rectangular &
lateral lenght:
5T mm
R... round & diameter
| HT | High temperature (optional) ‘ - ‘B1 28‘ Memory capacity total ‘ - Ex‘ Approvals
High temperature Memory capacity total (size) Approvals
HT High temperature B... ...Byte Ex Approval for Ex-Area
K... ...kByte

2015/11
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About the system

2.14  BLident® connection technology - type code
Type code — example

... -|RK4.5T|- 5|/ [s2500]

Type code - explanation

... |Usage ‘ - | RK4.5T ‘ Connector type ‘ - IE Cable length ‘ / ‘
I— Usage Connector type |— Cable length
FB- Food & Beverage type; RK4.5T female straight; 5-pin 0.3 03m
resistant to all common acid WK4.5T female angled; 5-pin 2 2m
and alkaline detergents and RS4.5T | ight: 5-pi 5 5
disinfectants; IP67 and IP69K - male straight; 5-pin m
10 10m
25 25m
50 50m

|52500| Connector quality

Connector quality

S$2500 standard version:
cable: UL 20963; cable jacket:
PUR, yellow, qualified for
drag chain use, oil-resistant,
highly flexible

S$2503 economic version:
cable: UL 20549; cable jacket:
PUR, black; qualified for
drag chain use, oil-resistant,
flexible
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System identification

2.1.5  BLident® handhelds - type code
PD-IDENT - | UHF - | 52D |- [RWB| TA |- |...| - |865-868

PD-IDENT TURCK handheld ‘ - | UHF ‘ Frequency range ‘ - | S2D | Barcode scanner ‘ - ‘
I— TURCK handheld Frequency range I—— Barcode scanner
HF  HF frequency range L1D Laser barcode scanner 1D
UHF UHF frequency range S1D Imager barcode scanner 1D

S2D Imager barcode scanner 2D

‘ RWB| TA ‘ Interface / Design ‘ - E Special variants ‘ - ‘865-868 ‘ Operating frequency
Design |— Special variants Operating frequency
TW TURCK Workapout Pro 3, SMART Device without monitor, max. 865-868 865...868 MHz: . g, EU
Industrial Desion 4 controls 915-920 915...920 MHz: us
TA TURCK Advance - Z: €.g.
Workabout Pro 4, 920-925 920...925MHz:e. g.

Industrial Design CN

UP TURCK UP, Economy
Design

—————== |nterface

RFID reader
WLAN
Bluetooth
Barcode scanner

nwowsx
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For your safety

2.2 Legal requirements

The following EU guidelines are relevant for the system:
2004/108/EC (EMC Directive)
2006/95/EC (Low-Voltage Directive)
94/9/EC (ATEX Directive)
1999/5/EC (R&TTE Directive)

The system consists of different components which do not all comply with the same directives
and which are also developed and manufactured according to different standards. Refer to the
relevant EC declarations of conformity to find the relevant directives and standards for individ-
ual components. The EC declarations of conformity are available online for download from the
Turck product database at www.turck.com.

2.3 Manufacturer and service

Turck supports you in your projects — from the initial analysis right through to the commission-
ing of your application. The Turck product database offers you several software tools for pro-
gramming, configuring or commissioning, as well as data sheets and CAD files in many export
formats. You can access the Product Database directly via the following address:
www.turck.de/products

For further inquiries in Germany contact the Sales and Service Team on:

Sales: +49 208 4952-380

Technical: +49 208 4952-390

For overseas inquiries contact your national Turck representative.

Hans Turck GmbH & Co. KG
WitzlebenstraRe 7

45472 Milheim an der Ruhr
Germany

3 Foryour safety

The system is designed according to the latest state-of-the-art technology. Residual hazards,
however, still exist.

Observe the following safety instructions in order to avoid hazards.

Turck accepts no liability for damage caused by failure to observe these safety instructions.

3.1 Intended use

The Turck BL ident® system is used for the contactless exchange of data between atag and a
read/write head for identifying objects in industrial environments.

Any other use is not in accordance with the intended use and may cause injury to persons and
possible damage. Turck is not liable for damage arising from improper use of the system.

3.2 Obvious misuse

16

The system is not suitable for the protection of persons and property and must not be used in
safety-related applications.
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General safety instructions

3.3 General safety instructions

Any incorrect use of the system may cause accidents.
The system must only be fitted, installed, operated and maintained by trained and qualified
personnel. When using the system in the Ex area, the user must also have additional knowl-
edge of explosion protection (EN 60079-14 etc.).
Only use the system in compliance with the applicable national and international regulations,
standards and laws.

Faulty repairs may cause device failure and accidents.
Do not intervene in system components or convert them.
Send the devices to Turck for repair.

Any extended stay within the area of radiation of the UHF read/write heads may be harmful to

health.
Observe minimum distances from the actively radiating surface of the UHF read/write head:

Region max. permissible total radiant Safety distance
output power

Europe 2 W ERP (according to ETSI) 0.24m

USA/Canada 4 W EIRP >0.30m

The radiation of the UHF read/write heads may have an adverse effect on the operation of elec-
trically controlled medical equipment.
Observe an additional distance from read/write heads up to the maximum transmission

distance.
34 Notes on Ex protection
If explosion protection measures are not implemented, there is a direct risk of explosion.
Observe national and international regulations for explosion protection.

Only use the device within the stated operating and ambient conditions (see device operat-
ing instructions and Ex approval specifications).

2015/11 17
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System components

4 System components
4.1 BL ident® interfaces

The BL20 (IP20) and BL67 (IP67) modular interfaces as well as the BL compact (IP67) interfaces
are available for the BL ident®system.

The modular interface sets consist of a gateway and one or several RFID modules, which can
also be expanded at a later time. Depending on the type of fieldbus up to 16 channels can be
fitted. One RFID module each with an electronic module and a base module are required for
every two channels.

Fig. 1:  BL20 standard gateway for Modbus TCP and
BL ident® interface set with BL20 standard gateway and four RFID modules

Fig.2:  BL20 ECO gateway for Modbus TCP and BL ident® interface set with BL20 ECO gateway
and four RFID modules
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BL ident® interfaces
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Fig.3: BL67 gateway for Modbus TCP and
BL ident® interface set with BL67 gateway and four RFID modules

The compact BL compact interfaces combine the functions of gateway and /0 electronics in
a fully encapsulated IP67 housing. Interfaces designed exclusively for connecting read/write
heads and also for the additional connection of field devices such as sensors or actuators are
available.

Fig.4: Compact BL ident® interface in IP67 (BL compact) for Modbus TCP

19
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System components

4.1.1  BLident® interfaces for Modbus TCP
The following BL20 interface sets are available for Modbus TCP:

BL20 interface sets

Interface set Ident no. Associated gateway
TI-BL20-E-EN-2 7030614 BL20-E-GW-EN
TI-BL20-E-EN-4 7030615 BL20-E-GW-EN
TI-BL20-E-EN-6 7030616 BL20-E-GW-EN
TI-BL20-E-EN-8 7030617 BL20-E-GW-EN
TI-BL20-PG-EN-2 1545053 BL20-PG-EN
TI-BL20-PG-EN-4 1545054 BL20-PG-EN
TI-BL20-PG-EN-6 1545055 BL20-PG-EN
TI-BL20-PG-EN-8 1545056 BL20-PG-EN
TI-BL20-PG-EN-S-2 1545086 BL20-PG-EN
TI-BL20-PG-EN-S-4 1545087 BL20-PG-EN
TI-BL20-PG-EN-S-6 1545088 BL20-PG-EN
TI-BL20-PG-EN-S-8 1545089 BL20-PG-EN

BL67 interface sets

The following BL67 interface sets are available for Modbus TCP:

Interface set Ident no. Associated gateway
TI-BL67-EN-S-2 1545150 BL67-GW-EN
TI-BL67-EN-S-4 1545151 BL67-GW-EN
TI-BL67-EN-S-6 1545152 BL67-GW-EN
TI-BL67-EN-S-8 1545153 BL67-GW-EN
TI-BL67-PG-EN-2 1545065 BL67-PG-EN
TI-BL67-PG-EN-4 1545066 BL67-PG-EN
TI-BL67-PG-EN-6 1545067 BL67-PG-EN
TI-BL67-PG-EN-8 1545068 BL67-PG-EN
TI-BL67-PG-EN-S-2 1545098 BL67-PG-EN
TI-BL67-PG-EN-S-4 1545099 BL67-PG-EN
TI-BL67-PG-EN-S-6 1545100 BL67-PG-EN
TI-BL67-PG-EN-S-8 1545101 BL67-PG-EN

BL compact interface sets

The following BL compact interface sets are available for Modbus TCP:
Interface set Ident no. Function
BLCEN-2M12LT-2RFID-S 6811450 2 x read/write head
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BL ident® interfaces

412 Possible combination of interfaces/gateways and RFID modules

The following tables show the possible combinations of BL20 and BL67 gateways with the
relevant RFID modules. Turck offers interface sets for all combination options with cage clamp
terminals for 2, 4, 6 or 8 read/write heads.

Combination of BL20 gateways and RFID modules

BL ident® Interface (set): Gateway and electronic modules (each with base module) - degree of protection IP20

Fieldbus Interface (set) Gateway Electronic modules
Type Type Gateway BL20-2RFID-A BL20-2RFID-S
x = Number of programmable PIB function block 8-byte I/O
channels communication
Modbus TCP  TI-BL20-E-EN-x BL20-E-GW-EN X
TI-BL20-PG-EN-x BL20-PG-EN X X
TI-BL20-PG-EN-S-x BL20-PG-EN X X

Combination of BL67 gateways and RFID modules

BL ident® Interface (set): Gateway and electronic modules (each with base module) - degree of protection IP67

Fieldbus Interface (set) Gateway Electronic
modules
Type Type Gateway BL67-2RFID-A BL67-2RFID-S
x = Number of programmable PIB function block 8-byte I/O
channels communication
Multiprotocol:  TI-BL67-EN-S-x BL67-GW-EN X
Modbus TCP,
PROFINET
and
EtherNet/IP™
Modbus TCP  TI-BL67-PG-EN-x BL67-PG-EN X X
TI-BL67-PG-EN-S-x BL67-PG-EN X X

2015/11
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System components

47 BL ident® read/write heads

The BL ident® read/write heads are used for contactless data exchange with the BL ident® tags.
For this the controller sends commands and data via the BL ident® interface to the read/write
head and receive the corresponding response data from the read/write head. The reading of
the IDs of all RFID tags in the read area or the writing of an RFID tag with a specific production
date are examples of typical commands.

To communicate with the tag, the data of the read/write head is coded and transferred via an
electromagnetic field, which at the same time supplies the tags with power.

Each BL ident® read/write head can communicate with a number of BL ident® tags. This requires
the read/write head and the tag to operate in the same frequency range. The detection ranges
of the devices — depending on power and frequency - vary from a few millimeters to several
meters. The specified maximum read/write distances only represent typical values under labo-
ratory conditions without allowing for the effect of materials. The achievable distances may be
different due to component tolerances, mounting location in the application, ambient condi-
tions and the effect of materials (particularly metal and liquids).

43  BLident®ident tags

A BL ident® tag is a mobile data memory consisting of a memory chip and a coupling ele-
ment (coil or antenna) and can be written or read without contact in an RFID system. Tags with
EEPROM and FRAM memories are available. Tags provide information on the object to which
they are fitted, e.g. a unique identification number, batch number or specific production data.
Prior to use, the tag is written with a worldwide uniquely assigned number, e.g. for UHF tags
compliant with the EPCglobal Class 1 Gen 2 standard (ISO18000-6C) and for HF tags according
to ISO 15693.

The BL ident® tags can be written and read by a number of BL ident® read/write heads with-
out contact. This requires the read/write heads and the tags to operate in the same frequency
range. The detection ranges of the devices — depending on power and frequency - vary from a
few millimeters to several meters. The specified maximum read/write distances only represent
typical values under laboratory conditions without allowing for the effect of materials. The
achievable distances may be different due to component tolerances, mounting location in the
application, ambient conditions and the effect of materials (particularly metal and liquids).

4.4 BL ident® handhelds

BL ident® handhelds enable tags to be read and written from any location. The read data is
displayed on a touch screen. They can be edited via the handheld and written to a tag.

45 RFID cables

Pre-assembled connection cables are available in standard or economy versions for the com-
munication between the components of the BL ident® system. RFID connection cables specially
designed for the food industry are also available.
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5 Mounting

DANGER
Potentially explosive atmosphere

Risk of explosion through spark ignition
When used in explosion hazardous areas:

» Mounting, connection and parameter setting are only permissible if there is no po-

tentially explosive atmosphere present.

» Observe the special device conditions stipulated by the Ex approval (see operating

instructions of the particular device).

5.1 Mounting BL20 interface sets

The BL20 interface set consists of a gateway with two mounting brackets, an end plate and up
to four electronic modules (RFID-S or RFID-A) and BL20-54T-SBBS base modules.

Fig.5: BL20 interface sets (8-channel for Modbus TCP): Version with standard gateway (left)

and
ECO gateway (right)

1545Q >y

Fig.6: Components of a BL20 interface set with a standard gateway: Gateway, base module, electronic module,

end plate, mounting bracket

2015/11
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Fig.7:  Components of a BL20 interface set with an ECO gateway: Gateway, base module, electronic module, end
plate, mounting bracket

The interface sets can be mounted in the control cabinet on a DIN rail according to EN 60715
(TH35).

5.1.1  General notes on mounting BL20 interface sets

When mounted in the control cabinet, the minimum clearance of the BL20 interface sets from
passive components is 10 mm. The minimum clearance from active components is 75 mm.
The first electronic component of each BL20 interface set is a gateway.

The mounting procedure is illustrated using the example of an interface set with a BL20 stan-
dard gateway. Interfaces with BL20 ECO gateways are mounted in the same way as standard
interfaces.

Depending on the power consumption, a bus refreshing module must be used after a cer-
tain number of electronic modules are used. Refer to the product data sheet for the power
consumption.

NOTE
ﬂ Connect the connection cable from the BL20 interface to the read/write heads to the
base modules before the interface is mounted in the control cabinet.
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Mounting BL20 interface sets

Mounting gateways and base modules

» Keep the space on the DIN rail left of the gateway free for the end bracket.
» Mount the gateway as per Fig. 8.

Fig.8: Mounting BL20 gateways (example: BL20 Standard gateway)

» Fasten the base module as per Fig. 9 on the DIN rail to the right of the gateway.

» Move the base module as far as possible to the left so that it is flush against the gateway or
the adjacent base module.

The side catches lock into the gateway or the adjoining base module. This ensures a reliable

connection between the modules and communication via the module bus.

Fig.9:  Mounting BL20 base modules
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5.1.3  Mounting the end bracket and end plate

» Snap fit a mounting bracket on the DIN rail to the left of the gateway.
» Move the mounting bracket flush up to the gateway.
» Screw the mounting bracket tight.

Fig. 10: Fastening the mounting bracket to the left of the gateway

26 Hans Turck GmbH & Co. KG | T +49 208 4952-0 | F +49 208 4952-264 | more@turck.com | www.turck.com



2015/11

Mounting BL20 interface sets

» Clip the end plate and a mounting bracket as per Fig. 11 to the right of the last base module
on the DIN rail.

» Move the end plate flush against the last base module until the plug connectors of the end
plate are securely inserted in the recesses of the base module.

» Move the mounting bracket into the recess of the end plate.

» Screw the mounting bracket tight.

Fig. 11: Fastening the mounting bracket and end plate
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5.14  Mounting BL20 electronic modules

NOTE

ﬂ For fault-free data processing a station can be fitted with a maximum of ten BL20-
RFID-S modules or four BL20-RFID-A modules. The reliability of the power supply de-
pends on the power consumption of the read/write heads connected to the electronic
modules. When using devices with a higher power consumption, at least one power
feeding module should be fitted after two RFID electronic modules.

» Push the electronic module evenly onto the base module as per Fig. 12 until there is an
audible click.

Fig. 12: Mounting BL20 electronic modules
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52  Mounting BL67 interface sets

The BL67 interface set comprises a gateway with two mounting brackets and an end plate, the
required number of appropriate electronic modules (RFID-S or RFID-A) and the same number
of BL67-B-2M12 base modules.

Fig. 14: Components of a BL67 interface set: Gateway, base module, electronic module, end plate, mounting
bracket

The BL67 interface sets can be mounted on a DIN rail according to DIN EN 60715 (TH35) or
screw mounted on a mounting plate. The interface sets can be aligned as required; they can be
mounted both horizontally and vertically.

The BL67 interface sets are designed for operation in the field and do not therefore have to be
mounted in the control cabinet.

52.1  General notes on mounting BL67 interface sets
The first electronic component of each BL67 interface set is a gateway.

Before mounting on the DIN rail or the mounting plate, screw the gateway and the base

modules together.
The maximum tightening torque for screws on the BL67 interface sets is 0.9...1.2 Nm
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522  BL67 - Mounting gateways and base modules

» Insert the first base module as per Fig. 15 in the module bus contacts of the gateway.
» Screw the gateway and the base module together.

» Fit all other base modules into the module bus contacts of the last base module.

» Fit the end plate onto the open bus module contacts of the last base module.

» Screw together the end plate and the base module.

Fig. 15: BL67 — Mounting gateways and base modules

@ NOTICE
Loss of IP67 protection

Damage to the device through the penetration of dust and humidity

» Tighten the screws of the base modules and the end plate (max. tightening torque:
0.9...1.2 Nm).

» Check the seals of the base modules for any damage.

30 Hans Turck GmbH & Co. KG | T +49 208 4952-0 | F +49 208 4952-264 | more@turck.com | www.turck.com



523

2015/11

Mounting BL67 interface sets

BL67 — Mounting electronic modules

NOTE

ﬂ For fault-free data processing a station can be fitted with a maximum of ten BL20-
RFID-S modules or four BL20-RFID-A modules. The reliability of the power supply de-
pends on the power consumption of the read/write heads connected to the electronic
modules. When using devices with a higher power consumption, at least one power
feeding module should be fitted after two RFID electronic modules.

» Push the electronic module evenly onto the base module as per Fig. 16.
» Screw together the electronic module and the base module.

Fig. 16: Mounting BL67 electronic modules

@ NOTICE
Loss of IP67 protection

Damage to the device through the penetration of dust and humidity
» Tighten the screws of the electronic modules (max. tightening torque: 0.9...1.2 Nm).
» Check the seals of the electronic modules for any damage.
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524  Mounting BL67 interfaces on a DIN rail

» Open the catches on the gateway and on the base modules with a screwdriver.
» Attach the BL67 interface to the DIN rail as per Fig. 17.

» Close the catches.

» Snap fit a mounting bracket on the DIN rail to the left of the gateway.

» Snap fit a mounting bracket on the DIN rail to the right of the last base module.
» Move the mounting bracket flush up to the interface set.

» Screw both mounting brackets tight.

Fig. 17: Mounting BL67 interfaces on a DIN rail
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Screw fastening BL67 interfaces on a mounting plate

» Connect the interface to the functional earth with a screw through the FE contact of the
gateway.

00000000

Fig. 18: FE contact on the top right hole of the gateway

NOTE
ﬂ If the mounting plate is not grounded, the ground must be implemented via a sepa-
rate grounding terminal on the FE contact of the gateway.

» Screw fasten the BL67 interface set on the mounting plate.
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53 Mounting BL compact interfaces

The BL compact interface sets are designed for operation in the field and can be screwed onto a
mounting plate.

54  Mounting HF read/write heads

NOTE
ﬂ Refer to the specific product operating instructions for the read/write head for the
mounting conditions.

» Mount the read/write heads with the associated fixing accessories.
» Avoid any type of metal in the vicinity of the read/write heads. Metal rails or similar objects
must not intersect the transmission zone. This would otherwise affect the field data.
» Observe the following requirements when mounting the read/write heads:
Minimum distance between read/write heads
Metal-free space for mounting read/write heads and tags in metal
Mounting several read/write heads on a metal frame or support.
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Mounting read/write heads on metal

Read/write heads mounted on metal couple part of the electromagnetic field onto the metal
support. If the minimum distance d and the metal-free spaces are observed, there is normally
no interaction between read/write heads. However susceptibility to interference may never-
theless result from a particularly poor orientation of the iron frame (example: Formation of a
magnetic ring in roller conveyor applications). This causes longer data transmission times and
error messages in the interface module.

Interaction between several read/write heads - Possible solutions

» Increase the distance d between the read/write heads.

Q
rite head

Fig. 19: Distance between two read/write heads

» Fit one or several iron stays in order to short parasitic fields.

additional strunck

Fig. 20: Additional iron stays

» Fit a 20...40 mm thick non-metallic spacer between the read/write head and the iron frame.
This reduces the parasitic interference of the field on the tag.

etaIIic
spacer

Fig. 21: Fitting a non-metallic spacer
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When using a BLxx-2RFID-A module with the PIB function block, the mutual interference of the
read/write heads can be prevented by using Selective mode. In Selective mode, only the chan-
nel with a tag located in its transmission window is active.

» Switch the read/write heads off and on via the PIB function block.

NOTE

ﬂ The achievable distances may differ by up to 30 % due to component tolerances,
mounting location and the effect of materials (particularly metal).
Before commissioning test the application particularly for read and write operations in
motion.

54.2  Mounting read/write heads in roller conveyor applications

36

Only Q800L400... TNLR read/write heads are suitable for use in the BL ident® system in roller

conveyor applications. Rollers electrically connected via the roller bearings and via the sup-

porting structure can modulate the high frequency magnetic field of the read/write head via

the roller bearings so severely when they rotate that no interference free data transmission is

possible. The read/write head must be shielded from the interference by the mounting of ad-

ditional shield plates.

» Design the shield plates as metal U profiles so that they do not touch the read/write head
directly.

» Mount the shield plates flush with the top edge of the read/write head (see figure).

» Electrically connect the shield plates with the supporting structure.

» Use plastic spacers for mounting the read/write head.

» Determine the permissible read/write distance and passing speed in real conditions.

The following figure shows mounting examples of the TNLR-Q80L400-... read/write head. The

dimensions used can vary depending on the application.

\/30 < Spacer (4x)
M5

<90
RN

Fig. 22: Mounting the TNLR-Q80L400-... read/write head in a U profile
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55  Mounting UHF read/write heads

NOTE
ﬂ Refer to the specific product operating instructions for the read/write head for the
mounting conditions.

» Mount the read/write heads with the associated fixing accessories.

» Observe the following points during engineering and when mounting the read/write heads:
Minimum and maximum distance between read/write heads
Minimum distance of read/write heads to conductive materials
Interaction when using several read/write heads
Parameter assignment of the read/write heads (e.g. setting of transmission output, operat-
ing frequency and RF transmission parameters) via the DTM or the RDemo and WebConfig
software tools.

55.1 Minimum and maximum distance between two read/write heads

The minimum and maximum distance between two read/write heads mounted next to each

other depends on the transmission output: The lower the transmission output, the smaller the

minimum distance possible.

» At least 20 cm should be selected as a guide value, and a distance of 50 cm or greater is
recommended.

20..50 cm¢
Fig. 23: Minimum distance between two read/write heads mounted next to or above each
other

With a portal configuration, the maximum distance between the read/write heads is 3.5 m
(Europe) and 4.0 m (USA, China).

Europa max. 3,5m J
USA, China max.4,0m

Fig. 24: Maximum distance for portal configurations
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552

38

Minimum distance of read/write heads to conductive materials

A conductive environment can cause the detuning of the read/write heads.
» Observe for mounting a minimum distance of 50 cm between a read/write head and the
ground, liquids or metals.

[ ' liqui
meta min. 50 cm iquid
-k
min. 50 cm
¥ ground

Fig. 25: Minimum distances to conductive materials for mounting read/write heads

NOTE

ﬂ Conductive materials in the environment can affect the read/write head and cause
detuning with an adverse effect on the resulting radio field. The read/write heads from
firmware version 1.39 can be tuned by means of software tools in order to compensate
any interference.
Interference can largely be compensated for by tuning the read/write head with the
Antenna Tuning function in the RDemo software tool. The Autotuning function can
also be activated in the WebConfig software tool. With this software the read/write
head cyclically carries out an automatic tuning to the conditions of the interference
environment.

NOTE

ﬂ The achievable distances may differ due to component tolerances, mounting location
and the effect of materials (particularly metal).
Before commissioning test the application particularly for read and write operations in
motion.
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56  Mounting HF tags

NOTE
ﬂ Refer to the product-specific data sheets for the tags to find the mounting conditions.

» Mount the tags according to application requirements. The tags can be stuck on or mounted
with screws.
» Use the plastic screws for screw mounting the tags.

NOTE
ﬂ For production reasons some smart label tags may not meet the conditions of the final
test. These tags are labelled by a black marking and can be disposed of.

v Xt

ﬂ NOTE
Carry out tests in real conditions in all cases.

5.6.1  Aligning the tags in the room

» Position the tags parallel to the active face of the read/write head.

Fig. 26: Parallel alignment of tag and read/write head (example)

NOTE
ﬂ Special conditions apply to the alignment of TW-R10-... and TW-R12-... tags (see
product data sheet).
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56.2  Mounting tags on metal

The following tags are suitable for direct mounting on metal:
TW-R10-M-B146
TW-R12-M-B146
TW-R30-M-B128
TW-R30-M-K2
TW-R50-M-B128
TW-R50-M-K2
TW-R80-M-B128
TW-R80-M-K2

Other types of tag must not be mounted directly on metal. The following measures must be
taken if these tags nevertheless have to be mounted in metal environments.

» Observe the required minimum distance from metals a when mounting. The minimum dis-
tance a depends on the design of the tag, a = 10 mm serves as a guideline.

Fig. 27: Figure: Minimum distance a
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» Fit a non-metallic spacer between the metal environment and the tag. The height h is at least
10 mm and depends on the combination of tag and read/write head.
» Carry out tests in real application conditions.

NOTE
ﬂ Non-metallic spacers enable mounting that does not interrupt the correct operation of
functions. The possible read/write distance can nevertheless be reduced.

non-metallic spacer data carrier

Fig. 28: Mounting with a non-metallic spacer
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Reducing metallic influences

Metal supports above the transmission zone between tag and read/write head affect the entire
field; the transmission zone is reduced.

plate
non-metallic spacer
metal core .
data carrier
read/write head

Fig. 29: Interfering metal supports

» Position the tags and read/write head in such a way that there are no more metal supports in
the transmission zone (see Fig. 30).

plate

metal core non-metallic spacer

data carrier
read/write head

Fig.30: Metal support outside of the transmission zone between the tag and the read/write
head.

» The transmission zone between the read/write head and the tag is no longer affected.
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Minimum distance between tags

» With single tag applications: Observe the recommended minimum distances (see product
data sheet). The minimum distance between the tags depends on the combination of tag
and read/write head.

» With multi-tag applications: Arrange the tags next to each other parallel to the active face of
the read/write head.
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57

5.7.1

44

Mounting UHF tags

NOTE
ﬂ Refer to the product-specific data sheets for the tags to find the mounting conditions.

» Mount the tags according to application requirements. The tags can be stuck on or mounted
with screws.
» Use the plastic screws for screw mounting the tags.

NOTE
ﬂ For production reasons some smart label tags may not meet the conditions of the final
test. These tags are labelled by a black marking and can be disposed of.

A RS

ﬂ NOTE
Carry out tests in real conditions in all cases.

Aligning the tags in the room

» In order to obtain the maximum read range, the tag antenna must be aligned parallel to the
read/write head.

/

Fig.31: Parallel alignment of tags
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A vertical alignment of tag antenna and read/write head antenna reduces performance and
results in a minimum read/write range.

Fig.32: Vertical alignment of tags
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572 Mounting tags on metal

The following tags are suitable for direct mounting on metal:
TW865-868-Q14L60-M-B110
TW902-928-Q14L60-M-B110
TW860-960-Q27L97-M-B112

Other types of tag must not be mounted directly on metal.

Liquids such as water and aqueous substances, ice, carbon have high RF attenuation in the UHF

band. The electromagnetic energy is partly reflected and absorbed by liquids.

» Observe a minimum mounting distance of 5...20 cm between tag and conductive materials.

» Do not mount directly on containers with liquids.

» Mount the tags with non-metallic fixing elements on a non-conductive material such as
plastic or wood.

573 Minimum distance between tags

» Observe a minimum distance of 50 mm between the tags.

e 50 mm -

Fig. 33: Minimum distance between tags
Minimum distance of smart label tags between each other

» Observe the required minimum distances between the smart label tags.

|
J

|-

50 mm 12 mm

|

Fig. 34: Minimum distances between smart labels tags
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574  Minimum distance of tags to conductive walls

Conductive walls and limits to the surrounding environment can shadow the radio field.
» Observe a minimum distance of 50..200 mm between the tags and conductive walls.

The effect of walls on the RF field is minimized in all cases if the polarization axis is vertical to
the wall.

—— conductive wall

polarization axis

-

~50...200
mm

Fig. 35: Minimum distances of tags to a conductive wall, polarization axis vertical

polarization axis

mm conductive wall
| ‘ W‘ !

Fig. 36: Minimum distances of tags to a conductive wall, polarization axis parallel

—— conductive wall
polarization axis
= 50...200 "
mm
50...200 .
mm conductive wall 1
T

Fig. 37: Minimum distance of tags to two conductive walls
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6 Installation

Fig. 38: Connection of BL ident® components

DANGER

Potentially explosive atmosphere

Risk of explosion through spark ignition

When used in explosion hazardous areas:

» Mounting, connection and parameter setting are only permissible if there is no po-
tentially explosive atmosphere present.

» Observe the special device conditions stipulated by the Ex approval (see operating
instructions of the particular device).

Observe the following procedure when connecting and installing the BL ident® components:
1.Connect the connection cables to the read/write heads to the base modules of the interface.
2.Mount the BL ident® interface at the required location.

3.Connect the connection cables to the read/write heads.

4.Connect the BL ident® interface to the fieldbus.

5.Connect the BL ident® interface to the power supply.
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6.1 Connecting BL20 interfaces and read/write heads

NOTICE
@ Compensation currents may occur if potential equalization is poor or if long cables are
used
Damage to the cables by exceeding the permissible shield current
» Connect the shield of the connection cable using a gateway shield terminal
(BS3511/KLBUE4-31.5) on one side at the interface (see Fig. 39).

Fig.39: Shield terminal (gateway)
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6.1.1  Connecting HF read/write heads to BL20 interfaces
» Connect the open end of the connection cables to the base modules of the BL20 interface as
shown in the wiring diagram below.

» Connect the M12 female connector of the connection cable to the read/write head.

Terminal layout with .../S2500 connection cable

Data 0 (BK)
| Data 0 (WH)
|
Read/write i LHED
head . Q@ -
L 2
[GND (BU) ' 8D i GND(3BU)
i ) i
+24VDC (BN) 85 {1 124vDC (1BN)
Y T ]
J_ 137 23
= ;lg P Read/write
(o)(®)| ¢ head
14 a4l i

| Data1(2BK) |
 Data 1 @wWh)

Fig. 40: Connection of HF read/write heads with .../S2500 connection cables

Terminal layout with .../S2501 connection cable

Data 0 (BU)
| Data 0 (WH)
[
Read/write CDEY
head i O@ -
o1 21 =
P T
GND (BK) L] i GND (3 BK)
OlCnr
12 22| i}
+24VDC (RD) %8 i | 424vDC (1RD)
Y AP ]
_l_ Read/write
head

: | Data1(28U) |
i/ Data1(4WH)

Fig.41: Connection of HF read/write heads with .../S2501 connection cable
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Terminal layout with .../52503 connection cable

Data 0 (BU)
| Data 0 (WH)
[
Read/write et
head I O@ -
TP
. T
[GND (BK) 88 i GND (3 BK)
+24VDC (RD) +24VDC (1 RD)
Y ]
_L_ Read/write
head

: | Data1(28U) |
i/ Data1(4WH)

N

Fig.42: Connection of HF read/write heads with .../S2503 connection cable
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6.1.2

52

Connecting UHF read/write heads to BL20 interfaces

DANGER

Effect on electrically controlled medical devices such as pacemakers

Danger to life due to malfunction or failure of medical equipment

» Find out the extent to which the radiation strength of your medical devices is af-
fected

» Find out the permissible distances from radiation sources for the devices you are
using.

» Observe an additional distance from active radiation sources up to the maximum
transmission distance of the radiation source.

1]

NOTICE

Faulty connection of the power supply with UHF read/write heads
Damage to the BL20 interface

» Connect the connection cables as shown in the wiring diagrams.
» Connect the power supply separately.

Terminal layout with .../S2500 connection cable

+12...24VDC (1 BN)

@ GND (3 BU) | | Read/write

Data 0 (4 WH) i i |head

Data 0 (2 BK)

Data 1 (2 BK)

L

T

Data 1 (4 WH)

+12...24VDC (1BN) || |Read/write

i i |head
GND (3 BU) L

Fig.43: Connection of UHF read/write heads with .../S2500 connection cable
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Terminal layout with .../S2501 connection cable

+12...24VDC (1 BN)

@ GND (3BU)

Data 0 (4 BK)

Data 0 (2 WH)

Data 1 (2WH)

1

T

Read/write
head

Data 1 (4 BK)

+12...24VDC (1 BN)

@ GND (3 BU)

Fig. 44: Connection of UHF read/write heads with .../S2501 connection cable

Read/write
head
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Terminal layout with .../S2503 connection cable

+12...24VDC(1RD)

@ GND (3 BK) Read/write

Data 0 (4 WH) head
Data 0 (2 BU)

-

RN

00

11 21
O
OO
12 22
0
OO0
13 23
0

(9)(9)
AN AN iy
14 b4 T
Data 1 (2 BU) ;
Data 1 (4 WH)

+12..24VDC(1RD) i : |Read/write
: head
GND (3 BK) L

Fig.45: Connection of UHF read/write heads with .../S2503 connection cable

Terminal layout for the connection cables

Wiring diagram Contact .../S2500 and FB.../S2500 .../S2503 (ECO) .../S2501
Signal Color Signal Color Signal Color

assignment assignment assignment
1 VrRwhead Brown (BN) VR-W head Red (RD) ViRwhead  Brown (BN)
2 2 Data Black (BK) Data Blue (BU) Data White (WH)

1(000)3 3 GND Blue (BU) GND Black (BK) GND Blue (BU)

5 f 4 Data White (WH) Data White (WH) Data Black (BK)

5 n.c. - n.c. - n.c. -

54 Hans Turck GmbH & Co. KG | T +49 208 4952-0 | F +49 208 4952-264 | more@turck.com | www.turck.com



6.1.3
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Connecting BL20 interfaces to the fieldbus

The BL20 Standard interfaces are connected to the fieldbus via the RJ45 socket on the gateway.

Fig. 46: BL20 gateway — RJ45 socket on the gateway

The BL20-ECO interfaces are connected to the fieldbus via an integrated RJ45 Ethernet switch
(marked red)

Fig.47: BL20-ECO gateway — RJ45 Ethernet switch on the gateway
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» Connect the gateway to the controller as per the following terminal layout with an RJ45 ter-
minal using an Ethernet cable.

C 1=TX +
2=TX -

3=RX +

4=n.c

W 5=n.c.
=RX -

6
87654321 7 _p'c.
8=n.c

Fig. 48: BL20 gateway — Terminal layout of the RJ45 socket

> If the BL ident® interface is used as the first or last station in the fieldbus communication, con-
nect a special bus plug connector with integrated terminating resistor. Otherwise communi-

cation malfunctions may occur.
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6.1.4
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Connecting BL20 interfaces and read/write heads

Connecting BL20 interfaces to the power supply

The power supply of the BL20 interface consists of the system power supply and the field
power supply.

The transformed system power supply is 5 VDC (from 24 VDC) and can supply a maximum of
1.5 A (Standard interfaces) and 0.5 A (ECO interfaces with a maximum number of connected
RFID electronic modules). This voltage is transferred with a core pair of the 7-core module bus
and is used to supply the module electronics on the module bus.

The field supply voltage is 24 VDC and can supply up to 10 A. This voltage is fed via a busbar
through the interface. The fieldbus module electronics and the connected devices are fed from
the field supply voltage.

Connecting BL20 Standard interfaces to the power supply
» Connect the power supply to the two connection terminals U, and Usys (field power supply

and system power supply) according to the following wiring diagram.
» Connect a voltage of 18...30 VDC (rated value 24 VDC) to the 2-pole screw terminals.

Field supply

Fig. 49: BL20 gateway - Power supply terminal
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Connecting BL20 ECO interfaces to the power supply

» Connect the power supply to the two connection terminals U, and Usys (field power supply
and system power supply) according to the following wiring diagram.
» Connect a voltage of 18...30 VDC (rated value 24 VDC) to the 2-pole cage clamp terminals.

Fig. 50: BL20 ECO gateway — Power supply terminal
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Connecting BL67 interfaces and read/write heads

6.2  Connecting BL67 interfaces and read/write heads
6.2.1  Connecting read/write heads to BL67 interfaces
» Connect the M12 plug connector of the connection cables to the base modules of the BL67

interface as shown in the wiring diagram below.
» Connect the M12 female connector of the connection cable to the read/write head.

Wiring diagram Contact  .../S2500 and FB.../S2500 .../S2503 (ECO) .../S2501
Signal Color Signal Color Signal Color
assignment assignment assignment
1 Vewhead Brown (BN) VRW head Red (RD) Vewhead  Brown (BN)
2 2 GND Blue (BU) GND Black (BK) GND Blue (BU)
3 1 3 Data Black (BK) Data Blue (BU) Data White (WH)
7 s 4 Data White (WH) Data White (WH) Data Black (BK)
5 n.c. - n.c. - n.c. -

Fig. 51: Connection cables - Terminal layout of plugs

Wiring diagram Contact  .../S2500 and FB.../S2500 .../S2503 (ECO) .../S2501
Signal Color Signal Color Signal Color

assignment assignment assignment
1 Vewhead Brown (BN) VRW head Red (RD) Vewhead  Brown (BN)
2 2 Data Black (BK) GND Blue (BU) Data White (WH)

1 oo 3 3 GND Blue (BU) GND Black (BK) GND Blue (BU)

5 (z 4 Data White (WH) Data White (WH) Data Black (BK)

5 n.c. - n.c. - n.c. -

Fig. 52: Connection cables - Terminal layout of female connector
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6.2.2  Connecting BL67 interfaces to the fieldbus

Programmable gateways and Standard gateways before version VN03-00 are provided with a
4-pole M12 x 1 socket for connecting to Ethernet. Standard gateways from version VN 03-00 are
provided with two identical Ethernet terminals.

ETH1

Fig. 53: Ethernet terminal: programmable gateway and standard gateway before version VN
03-00 (left), standard gateway from version VN 03-00 (right)

» Connect the M12 plug connector of the connection cable to the Ethernet terminal of the
gateway.

» Connect the RJ45 plug of the connection cable to the controller.

» If the BL ident® interface module is used as the first or last station in the fieldbus communica-
tion, connect a special bus plug connector with integrated terminating resistor. Otherwise
communication malfunctions may occur.
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Connecting BL67 interfaces and read/write heads

6.2.3  Connecting BL67 interfaces to the power supply

The power supply of the BL67 interface consists of the system power supply and the field
power supply.

The transformed system supply voltage is 5 VDC (from 24 VDC) and can supply up to 1.5 A. This
voltage is transferred with a core pair of the 7-core module bus and is used to supply the mod-
ule electronics on the module bus.

The field supply voltage is 24 VDC and can supply up to 10 A. This voltage is fed via a busbar
through the interface. The fieldbus module electronics and the connected devices are fed from
the field supply voltage.

Fig. 54: Power supply connection: programmable gateway and Standard gateway before ver-
sion VN 03-00 (left), Standard gateway from version VN 03-00

» Connect the power supply via the 7/8 " connector on the gateway as shown in .

Wiring diagram Contact Color 7/8" Designation
3 1 black GND
4 2 2 blue GND
51 3 green/ PE Protective earth
yellow
4 brown V, (Upg) Supply of the nominal voltage for inputs (sensor supply

Vaw head)- This also provides the system supply

5 white Vo (U) Supply of the nominal voltage for outputs
(with the BL67-2RFID module supplies the fieldbus
microcontroller)

Fig.55: 7/8"plug connector on the gateway
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6.3  Connecting BL compact interfaces and read/write heads

6.3.1  Connecting read/write heads to BL compact interfaces
The BL compact interfaces are provided with two M12 socket connectors for connecting read/
write heads.
Fig. 56: BL compact - Connections for the read/write heads
» Connect the M12 plug connector of the connection cables to the BL compact interface as
shown in the wiring diagram below.
» Connect the M12 female connector of the connection cable to the read/write head.
Wiring diagram Contact  .../S2500 and FB.../S2500 .../S2503 (ECO) .../52501
Signal Color Signal Color Signal Color
assignment assignment assignment
1 Vrwhead Brown (BN) VRW head Red (RD) Viwhead  Brown (BN)
2 2 GND Blue (BU) GND Black (BK) GND Blue (BU)
>
3 1 3 Data Black (BK) Data Blue (BU) Data White (WH)
7 s 4 Data White (WH) Data White (WH) Data Black (BK)
5 n.c. - n.c. - n.c -
Fig. 57: Connection cables - Terminal layout of plugs
Wiring diagram Contact  .../S2500 and FB.../S2500 .../S2503 (ECO) .../S2501
Signal Color Signal Color Signal Color
assignment assignment assignment
1 Vrwhead Brown (BN) VRW head Red (RD) Viwhead  Brown (BN)
2 2 Data Black (BK) GND Blue (BU) Data White (WH)
e}
100 0)3 3 GND Blue (BU) GND Black (BK) GND Blue (BU)
5 (z 4 Data White (WH) Data White (WH) Data Black (BK)
5 n.c. - n.c. - n.c -

Fig. 58: Connection cables - Terminal layout of female connector
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6.3.2

2015/11

Connecting BL compact interfaces and read/write heads

Connecting BL compact interfaces to the fieldbus

The BL compact interfaces are provided with two M12 socket connectors for connecting to the
Ethernet.

Fig. 59: Ethernet terminal: BL compact interfaces

» Connect the M12 plug connector of the connection cable to the Ethernet terminal of the
interface.

» Connect the RJ45 plug of the connection cable to the controller.

» If the BL ident® interface is used as the first or last station in the fieldbus communication, con-
nect a special bus plug connector with integrated terminating resistor. Otherwise communi-
cation malfunctions may occur.
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6.3.3  Connecting BL compact interfaces to the power supply

Fig. 60: Power supply connection: BL compact interfaces

» Connect the power supply via the M12 plug connectors on the interface as shown in wiring
diagrams below.

Wiring diagram Contact M12 Designation

1 ] Supply of the nominal voltage for inputs (sensor supply Vray head)

2 2 Vo Supply of the nominal voltage for outputs

>
3 1 3 GND

4 GND

4 5
5 PE Protective earth

Fig.61: Terminal layout of the M12 plug connector

Wiring diagram Contact M12 Designation
1 V| Supply of the nominal voltage for inputs (sensor supply Vgw head)
2 2 Vo Supply of the nominal voltage for outputs
1(000)3 3 GND
R 4 GND
5 PE Protective earth

Fig. 62: Terminal layout of the M12 socket connector
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/7 Commissioning

7.1 Connecting a BL ident® interface with a PC

The PACTware™ software enables access to the BL ident® interfaces via a host PC. The following
are some of the functions that can be executed:

= Addressing gateways

= Creating a station report

» Interface parameterization

7.1.1  PACTware™ - Creating a project

» Connect the gateway to a host PC via the Ethernet interface.

File Edit View Project Device Extras Window Help

£ Connect
i Disconnect

Add device

DSHS & [Be AR08 8%x%H

Topology Scan

» Launch PACTware™.
I :?
<

» Right-click Host PC.
» Choose Add Device

PACTware
supported by

Hans Turck GmbH & Co

Seri.. Date Source Error

L) ST
[o | o] <NonAME>

2015/11

H Administrator |

Fig.63: Adding a device
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> Add BL Service Ethernet to the project tree.

All Devices

Device

e Ethemet

=" BL Service RS232 BL Service Turck DTM specific 1.0.0 / 2007-0¢ 1.2.0 Addendu 1.00.2107 / 2015-08-06

% HART Communication HART CodeWrights GmbH FDT 1.0.52/2015-( 1.2.0 Addendu 1.0.52 / 2015-03-17
& [0-Link USB Master 20 10-Link 10-Link FOT 2000002 /200121 2.00.0002 / 2013-08-19

DTM version
ddendy| 1.00.211 015 b

BL Service Ethernet Com DTM
)

Fig. 64: Adding BL Service Ethernet to the project tree

» Right-click the device to be added.
» Open the Bus Address Management.

File Edit View Project Device Extras Window Help

DEHAa B

o=

Device tag
B HOST PC

Connect
Disconnect

Load from device
Store to device

Parameter
Measured value
Simulation

Diagnosis

Display channels
Channels

Topology Scan
Diagnostic Scan

Print

Up-/Download-Manager

Additional functions

4 Compare offline

Add device
Exchange device
Delete device

Compare online
Set value
Scan list

PACTware

supported by

Properties <TCP:192.168.1.50>BL Service Ethernet Identification

About / Update DTM
Busaddress management
Browser
HIMA Export
Accessory

Preset DTM TAG (address/tag)

Hans Turck GmbH & Co

DTM maintenance
Seri.. Date Source |, Write device data to file

lax %[0 <nomamE>

66

" Administrator ‘

Fig.65: Opening Bus Address Management
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» Click the following icon to search for connected gateways

hernet

er ethernet communication DT

w lwplet | @ B | 42 2 Busaddress management

Onling available dewvite o devices manually|

Lam-Yerbindung 3 (192.168.1.50/255.265.255.0) V]

Device type Cnline |10 | IF address Metmask Gateway Ethe

Fig. 66: Search function in the Bus address management

» Change the network settings of the gateway if necessary.
» Click Add device/DTM to the project

rnet

ethernet communication DTM

Hv @ @ BOHw | plel |00 &8

Online available devices I Add devices manually|

EN-\-’erbindu_nq 3(192.168.1.60/255.255.255.0)

Device type Cnline D |IP address
i Vis J0)| 150001 F ]

| v————————

Planned devices I

Dewvice type Orline ID  |Busaddress Designation ('Tag') Dewvice shott name

Cancel l [ Appalhy

= Disconnected ’_|

Fig.67: Add device/DTM to project

2015/11
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» Confirm the subsequent prompt with OK.

[+] &dd DTMs for connected modules as well

[ cencel ok |

Fig.68: Adding DTMs for the RFID electronic modules
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7.1.2

2015/11

Connecting a BL ident® interface to the host PC

» Right-click Host PC in the project tree

: Topology Scan
- Diagnostic Scan

Up-/Download-Manager

#] Add device

Connecting a BL ident® interface to the host PC
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7.1.3  Creating a station report

» Right-click the gateway in the project tree.
» Choose Additional functions > Station report

File Edit View Project Device Extras Window Help
NEEHE @ [Be @R 0 %853 H,

Device tag
B HOST PC
== TCP:192.168.1.50

Disconnect

Get device state
Load from device
Store to device

Parameter 3
Measured value

Simulation

Diagnosis

Do not display channels
Channels 3

Topology Scan
Diagnostic Scan
Up-/Download-Manager

Print »

Additional functions 4 Compare offline
Add device Compare online
Exchange device Set value

Delete device Scan list

Properties <192.168.1.254/BL67-GW-EN (>= VN 03-00)>BL67-GW-EN (== VN 03-00) 10 configurator
Gateway Quick Start
Identification

About / Update DTM
Verify station
R —
Seri.. Date Source Error message Compare with connected station
Force Maode control

Accessory
Import BL compact files
DTM maintenance

Help about device
Open device website

|'®'~/|| * ”0” <NONAME > ” Administrator ‘ HJ Write device data to file

Fig. 69: Creating a station report
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» Select the data the station report is to contain (example: only fieldbus report).

» Confirm the selection with OK.

e~ # T
Repoﬂl Labelsl Ex—f’lmpor‘tl

[ An chapters
Station overview Station image
Station parameters Station dimension

[ Jincluding all parameters of BL remote (Devicenet) nodes

Station article list [7] All gateways fram bus
[ Jwith prices
- pricelist notimported -

Station report

Fieldbus repo, if awvailable
Dewvice documentation (onky PDF)

Options
Unit

[r Disconnectad ,_|

Fig. 70: Selecting data for the station report
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7.2 Addressing gateways

The addressing of the gateway determines the position of the BL ident® interface as a network
station. The IP address is based on the IPv4 standard. IPv4 addresses consist of four 8-bit num-
ber blocks (1 byte). This provides a value range per number block of 0...255.

Example of an IPv4 address: 192.168.1.254

7.2.1  Addressing Standard gateways (BL20 and BL67)
The BL20 Standard gateways and the BL67 gateways are provided with three decimal rotary

coding switches for setting the IP address. The rotary coding switches are located together with
the Service interface under a cover.

Adr. x 100 0
9 01 9 21
8 2 3 g X 100
7 3 6 5 4
6 5 4
0
x 10
9 1 9 1 6 5 4
OOk
7 3 7 3 0
9 1
6 5 4 6 5 4 3 5 i
Adr.x 10 Adr. x 1 7 3
6 5 4

Fig. 71: Rotary coding switches on the BL20 gateway (left) and on the BL67 gateway (right)

LED indication during addressing

LED indication of BL20 gateways and LED indication of BL67 gateways Meaning

BL67 gateways before VN03-00 from VN03-00

“MS” LED flashing red “BUS" LED flashing red Gateway ready for addressing
“MS” LED flashing green “BUS” LED flashing green Addressing completed
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Setting option

Addressing gateways

BL20 Standard gateways and BL67 gateways — Addressing options

The IP address of the Standard gateways can be set in different ways. The following addressing
options can be selected via the three rotary coding switches on the gateway:

Rotary coding switch Meaning

Default address

000

IP address: 192.168.1.254
Subnet mask: 255.255.255.0
Default gateway: 192.168.1.001

Rotary mode

1...254

In Rotary mode, the last byte of the IP address can be set manually on the
gateway. The other network settings can be stored retentively in the gateway
memory and cannot be changed in Rotary mode. Addresses from 1...254

can be set. The addresses 0 and 255 are used for broadcast messages in the
subnet.

BootP mode

300

In BootP mode, the complete IP address is assigned automatically by a BootP
server in the network. The subnet mask assigned by the BootP server and the
default gateway address are stored retentively in the gateway memory.

DHCP mode

400

In DHCP mode, the complete IP address is assigned automatically by a DHCP
server in the network. The subnet mask assigned by the DHCP server and the
default gateway address are stored retentively in the gateway memory. DHCP
supports three types of IP address assignment:

Automatic address assignment: The DHCP server assigns a permanent IP ad-
dress to the client.

Dynamic address assignment: The IP address assigned by the server is always
only reserved for a specific period. After this time has elapsed or after the
explicit release by a client, the IP address is reassigned.

Manual address assignment: A network administrator assigns an IP address to
the client. DHCP is only used in this case to transfer the assigned IP address to
the client.

PGM mode

500

In PGM mode, the complete IP address is assigned manually via the PACT-
ware™ software or via a web server (gateways from version VN 03-00). In

PGM mode, the set IP address and the subnet mask are stored in the gateway
memory. All network settings (IP address, subnet mask, default gateway) are
accepted by the internal EEPROM of the module.

PGM-DHCP mode

600

In PGM-DHCP mode, the gateway transmits DHCP requests until it is assigned
a fixed IP address. The DHCP client is automatically deactivated if an IP ad-
dress is assigned to the gateway via the DTM or a web server.

2015/11
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74

Addressing a Standard gateway in Rotary mode

» Open the cover above the rotary coding switches.
» Set the last byte of the required IP address manually via the rotary coding switches. Each
switch represents one digit in the last byte of the IP address.

x 100

X 10

X1

Fig. 72: Example: Setting of the rotary coding switches for the IP address 192.168.1.173 (BL67
gateway)

» Carry out a voltage reset.

= The set number block is accepted as the last byte of the IP address. The other bytes of the IP
address as well as the subnet mask are automatically accepted by the internal non-volatile
memory of the gateway.

> NOTICE! IP20 (BL20) or IP67 (BL67) protection is not provided when the cover is opened over
the rotary coding switches. Device damage through penetrating foreign objects or liquids is
possible. Close the cover tightly above the rotary coding switches.

NOTE
ﬂ The number block set in Rotary mode, is not accepted in the gateway memory.

Addressing a Standard gateway in BootP mode
» Open the cover above the rotary coding switches.
» Set the rotary coding switches to 300.

9 01

8 2| %100

8 2
1
7@3 x10

X1

Fig. 73: Setting of the rotary coding switches for addressing in BootP mode (BL67 gateway)

» Carry out a voltage reset.

> NOTICE! IP20 (BL20) or IP67 (BL67) protection is not provided when the cover is opened over
the rotary coding switches. Device damage through penetrating foreign objects or liquids is
possible. Close the cover tightly above the rotary coding switches.

Addressing a Standard gateway in DHCP mode

» Open the cover above the rotary coding switches.
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Addressing gateways

» Set the rotary coding switches to 400.

9 01
8 2| %100

8 2
1
1OHE

X1

Fig. 74: Setting of the rotary coding switches for addressing in DHCP mode (BL67 gateway)

» Carry out a voltage reset.

> NOTICE! IP20 (BL20) or IP67 (BL67) protection is not provided when the cover is opened over
the rotary coding switches. Device damage through penetrating foreign objects or liquids is
possible. Close the cover tightly above the rotary coding switches.

Addressing a gateway in PGM mode

» Open the cover above the rotary coding switches.
» Set the rotary coding switches to 500.

8 2| %100

8 2
1
1OHEL

X1

Fig. 75: Setting of the rotary coding switches for addressing in PGM mode (BL67 gateway)

» Carry out a voltage reset.

> NOTICE! IP20 (BL20) or IP67 (BL67) protection is not provided when the cover is opened over
the rotary coding switches. Device damage through penetrating foreign objects or liquids is
possible. Close the cover tightly above the rotary coding switches.

» Address the gateway via the DTM or a web server.
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Addressing the gateway in PGM-DHCP mode

» Open the cover above the rotary coding switches.
» Set the rotary coding switches to 600.

X 100

8 2
1
1OHEL

X1

Fig. 76: Setting of the rotary coding switches for addressing in PGM-DHCP mode (BL67
gateway)

» Carry out a voltage reset.

> NOTICE! IP20 (BL20) or IP67 (BL67) protection is not provided when the cover is opened over
the rotary coding switches. Device damage through penetrating foreign objects or liquids is
possible. Close the cover tightly above the rotary coding switches.

» Optional: Address the gateway via the DTM or a web server.
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Addressing gateways

7.2.2  Addressing ECO gateways (BL20)

The BL20 ECO gateways via DIP switches for setting the IP address. The address switches 20...
27 allow the setting of the last byte of the IP address as a binary number.

0»1
== |20
o =2 2!
o | = 22
x | == |23
8 |o=|2*
< | =20
[ |26
[ |27

MODE | (==

CFG| =3
off - on

Fig. 77: DIP switches on the BL20-ECO gateway

The DIP switches have the following meaning:

Designation Function

20...27 Switches for setting the last block of the gateway IP or for selecting the addressing mode

MODE Switch for switching between manual addressing and software or server-based addressing

CFG Switch for accepting the actual configuration. The gateway accepts the actual arrangement of modules in

the non-volatile internal memory.

LED indication during addressing

LED indication of BL20 gateways and LED indication of BL20-ECO Meaning

BL67 gateways before VN03-00 gateways

“MS" LED flashing red “BUS” LED flashing red/green Gateway ready for addressing
“MS” LED flashing green “BUS” LED flashing green Addressing completed
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Setting option

BL20-ECO gateways — Addressing options

The IP address of the ECO gateways can be set in different ways. The following addressing op-
tions can be selected via the DIP switches on the gateway:

DIP switches

MODE

CFG

20...27

Meaning

Default address

off

off

0

IP address: 192.168.1.254
Subnet mask: 255.255.255.0
Default gateway: 192.168.1.001

Manual setting via
DIP switches

off

off

1...254

The last block of the IP address can be set manually via DIP
switches.

The other network settings can be stored retentively in the
gateway memory and cannot be changed manually via the DIP
switches. Addresses from 1..254 can be set. The addresses 0 and
255 are used for broadcast messages in the subnet.

DHCP mode

on

off

In DHCP mode, the complete IP address is assigned automatical-
ly by a DHCP server in the network. The subnet mask assigned
by the DHCP server and the default gateway address are stored
retentively in the gateway memory. DHCP supports three types
of IP address assignment:

Automatic address assignment: The DHCP server assigns a per-
manent IP address to the client.

Dynamic address assignment: The IP address assigned by the
server is always only reserved for a specific period. After this time
has elapsed or after the explicit release by a client, the IP address
is reassigned.

Manual address assignment: A network administrator assigns an
IP address to the client. DHCP is only used in this case to transfer
the assigned IP address to the client.

BootP mode

on

off

In BootP mode, the complete IP address is assigned automati-
cally by a BootP server in the network. The subnet mask assigned
by the BootP server and the default gateway address are stored
retentively in the gateway memory.

PGM mode

on

off

In PGM mode, the complete IP address is assigned manually via
the PACTware™ software or via a web server (gateways from ver-
sion VN 03-00). In PGM mode, the set IP address and the subnet
mask are stored in the gateway memory. All network settings

(IP address, subnet mask, default gateway) are accepted by the
internal EEPROM of the module.

PGM-DHCP mode

on

off

In PGM-DHCP mode, the gateway transmits DHCP requests until
it is assigned a fixed IP address. The DHCP client is automatically
deactivated if an IP address is assigned to the gateway via the
DTM or a web server.

reserved

off

16

F_Reset function

on

off

32

Resets the gateway to the factory setting.
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Addressing gateways

Addressing the ECO gateway manually via DIP switches

» To access the DIP switches pull up the cover out of the housing.
» Set the last byte of the required IP address manually via the DIP switches.

Example: The number 1734, corresponds to 10101101;,. The corresponding switch position
from 27 to 20is 10101101.

0»1
=11 |20
o =2 2!
@ | =0 22
x |28
8 |o=|2*
< |20
[ |26
= |2’

MODE | (==

CFG| =3
off - on

Fig. 78: Example: Setting of the DIP switches for the IP address 192.168.1.173 (BL20-ECO
gateway)

» Carry out a voltage reset.

= The set number block is accepted as the last byte of the IP address. The other bytes of the IP
address as well as the subnet mask are automatically accepted by the internal non-volatile
memory of the gateway.

NOTE
ﬂ The number block set manually via the DIP switches is not accepted in the gateway
memory.

Addressing an ECO gateway in BootP mode

» To access the DIP switches pull up the cover out of the housing.
» Set the DIP switch 2" and MODE switch to 1.

0»1
== |20
o [E=D2!
o | = 22
x | == |28
8 |o=|2*
< | =20
[ |26
|27

MODE | =0

CFG| =3
off - on

Fig. 79: Setting of the DIP switches for the IP addressing in BootP mode (BL20-ECO gateway)

» Carry out a voltage reset.
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Addressing the ECO gateway in DHCP mode

» To access the DIP switches pull up the cover out of the housing.
» Set the DIP switch 2° and MODE switch to 1.

t

ADDRESS
N
N

Fig. 80: Setting of the DIP switches for addressing in DHCP mode (BL20-ECO gateway)
» Carry out a voltage reset.
Addressing the ECO gateway in PGM mode

» To access the DIP switches pull up the cover out of the housing.
» Set the DIP switch 22 and MODE switch to 1.

t

ADDRESS

N,
o

MODE
CFG

off < on

Fig. 81: Setting of the DIP switches for addressing in PGM mode (BL20 ECO gateway)

» Carry out a voltage reset.
» Address the gateway via the DTM or a web server.
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Addressing the ECO gateway in PGM-DHCP mode

» Open the cover above the rotary coding switches.
» Set the DIP switch 23 and MODE switch to 1.

01

ADDRESS

Fig. 82: Setting of the DIP switches for addressing in PGM DHCP mode (BL20 ECO gateway)

> Carry out a voltage reset.
» Optional: Address the gateway via the DTM or a web server.
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7.2.3  Addressing BL compact interfaces

Setting option

The BL20 compact interfaces are provided with two decimal rotary coding switches for set-
ting the IP address. Up to 99 addresses (01...99) can be set with the rotary coding switches. The
fieldbus address 00 must not be assigned. The rotary coding switches are located together with
the Service interface under a cover.

Fig. 83: Rotary coding switches on the BL compact interface

LED indication during addressing

LED indication Meaning
“BUS” LED flashing red Gateway ready for addressing
“BUS” LED flashing green Addressing completed

BL compact interfaces — Addressing options

The IP address of the interfaces can be set in different ways. The following addressing options
can be selected via the two rotary coding switches on the interface:

Rotary coding switch Meaning

Default address

00 IP address: 192.168.1.254
Subnet mask: 255.255.255.0
Default gateway: 192.168.1.001

Rotary mode

1...92 In Rotary mode, the last byte of the IP address can be set manually on the
gateway. The other network settings can be stored retentively in the gateway
memory and cannot be changed in Rotary mode. Addresses 1...92 can be set.

BootP mode

93 In BootP mode, the complete IP address is assigned automatically by a BootP
server in the network. The subnet mask assigned by the BootP server and the
default gateway address are stored retentively in the gateway memory.

DHCP mode

94 In DHCP mode, the complete IP address is assigned automatically by a DHCP
server in the network. The subnet mask assigned by the DHCP server and the
default gateway address are stored retentively in the gateway memory. DHCP
supports three types of IP address assignment:

Automatic address assignment: The DHCP server assigns a permanent IP ad-
dress to the client.

Dynamic address assignment: The IP address assigned by the server is always
only reserved for a specific period. After this time has elapsed or after the
explicit release by a client, the IP address is reassigned.

Manual address assignment: A network administrator assigns an IP address to
the client. DHCP is only used in this case to transfer the assigned IP address to
the client.
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Setting option

Addressing gateways

Rotary coding switch Meaning

PGM mode

95 In PGM mode, the complete IP address is assigned manually via the PACT-
ware™ software or via a web server. In PGM mode, the set IP address and
the subnet mask are stored in the gateway memory. All network settings (IP
address, subnet mask, default gateway) are accepted by the internal EEPROM
of the module.

PGM-DHCP mode

926 In PGM-DHCP mode, the gateway transmits DHCP requests until it is assigned
a fixed IP address. The DHCP client is automatically deactivated if an IP ad-
dress is assigned to the gateway via the DTM or a web server.

97...99 Vendor specific

2015/11

Addressing an interface in Rotary mode

» Open the cover above the rotary coding switches.
> Set the last byte of the required IP address manually via the rotary coding switches. Each
switch represents one digit in the last byte of the IP address.

Fig. 84: Example: Setting of the rotary coding switches for the IP address 192.168.1.1

» Carry out a voltage reset.

= The set number block is accepted as the last byte of the IP address. The other bytes of the IP
address as well as the subnet mask are automatically accepted by the internal non-volatile
memory of the gateway.

» NOTICE! IP67 protection is not provided when the cover is opened over the rotary coding
switches. Device damage through penetrating foreign objects or liquids is possible. Close the
cover tightly above the rotary coding switches.

NOTE
ﬂ The number block set in Rotary mode, is not accepted in the memory interface.
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Addressing an interface in BootP mode

» Open the cover above the rotary coding switches.
» Set the rotary coding switches to 93.

Fig. 85: Setting of the rotary coding switches for addressing in BootP mode

» Carry out a voltage reset.

» NOTICE! IP67 protection is not provided when the cover is opened over the rotary coding
switches. Device damage through penetrating foreign objects or liquids is possible. Close the
cover tightly above the rotary coding switches.

Addressing an interface in DHCP mode

» Open the cover above the rotary coding switches.
> Set the rotary coding switches to 94.

Fig. 86: Setting of the rotary coding switches for addressing in DHCP mode

» Carry out a voltage reset.

» NOTICE! IP67 protection is not provided when the cover is opened over the rotary coding
switches. Device damage through penetrating foreign objects or liquids is possible. Close the
cover tightly above the rotary coding switches.
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Addressing gateways

Addressing an interface in PGM mode

» Open the cover above the rotary coding switches.
» Set the rotary coding switches to 95.

Fig. 87: Setting of the rotary coding switches for addressing in PGM mode

» Carry out a voltage reset.

» NOTICE! IP67 protection is not provided when the cover is opened over the rotary coding
switches. Device damage through penetrating foreign objects or liquids is possible. Close the
cover tightly above the rotary coding switches.

» Address the gateway via the DTM or a web server.

Addressing the gateway in PGM-DHCP mode

» Open the cover above the rotary coding switches.
» Set the rotary coding switches to 96.

Fig. 88: Setting of the rotary coding switches for addressing in PGM-DHCP mode

» Carry out a voltage reset.

» NOTICE! IP67 protection is not provided when the cover is opened over the rotary coding
switches. Device damage through penetrating foreign objects or liquids is possible. Close the
cover tightly above the rotary coding switches.

» Optional: Address the gateway via the DTM or a web server.
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7.24  Addressing gateways with the DTM (PGM mode and PGM-DHCP mode)

» Connect the gateway to a host PC via the Ethernet interface.
» Launch PACTware™.
» Right-click Host PC.
» Choose Add Device

File Edit View Project Device Extras Window Help
DSHE @ ([BE D08 3%E | H

Connect
Disconnect

Topology Scan
Add device

PACTware

supported by
Hans Turck GmbH & Co

Seri.. Date Source Error

Rl FT—
| [0 <Nonames

Fig.89: PACTware™ - Adding a device

H Administrator |

> Add BL Service Ethernet to the project tree.

Device Versior FDT version | DTM version

i 1.0 1.2.0 Addendy 1.00.2 2015-08-06
=" BL Service RS232 BL Service Turck DTM speci 1.0.0 / 2007-0¢ 1.2.0 Addendu 1.00.2107 / 2015-08-06
= HART Communication HART CodeWrights GmbH FDT 1.052/2015-0 1.2.0 Addendu 1.0.52 / 2015-02-17
& 10-Link USB Master 20 10-Link IO-Link FDT 2000002 /20:1.21 2.00.0002 / 2013-08-19

BL Service Ethernet Com DTM
L

oK | Cancel )
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» Right-click the device to be added.
» Open the Bus Address Management.

File Edit View
DEHAa B

Project Device Extras Window Help
o=

Device tag
B HOST PC

Connect
Disconnect

Load from device
Store to device

Parameter
Measured value
Simulation

Diagnosis

Display channels
Channels

Topology Scan
Diagnostic Scan
Up-/Download-Manager

Seri.. Date Source
|

1]

PACTware

supported by

Print »
Additional functions 4 Compare offline
Add device Compare online
Exchange device Set value
Delete device Scan list
Properties <TCP:192.168.1.50>BL Service Ethernet Identification

About / Update DTM

Busaddress management
Browser

HIMA Export

Accessory

Preset DTM TAG (address/tag)
DTM maintenance

Hans Turck GmbH & Co

Write device data to file

lax %[0 <nomamE>

" Administrator ‘

Fig.91: Opening Bus Address Management
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» Click the following icon (marked in red) to search for connected gateways

rnet

ethernet communication DTM

w el |8 M| & 2 Busaddress management

Online awvailable devices | Add devices manuallyl

LAN—Verbindunu 3 (192.168.1.50/265.255.255.0)

Desvice type Onling ID | IP address Metmask

el

Flanned devices |

Desvice type Onling ID | Busaddress Designation ('Tag" Dewvice shal

[z Disconnected |_|

Fig.92: Search function in the Bus address management
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» Change the required network settings of the gateway if necessary.
» Confirm with Accept

rmet

ethernet communication DTM

B @2 B 0w |pliet [ Q0| &8

Onling awvailable devices | Add devices manuallyl

LAN-Verbindunq 3(192.168.1.50/255.255.256.0)

Device type

Flanned dewvices |

Device type Onling ID | Busaddress Designation ['Tag') Device short name

] I Cancel

| |

Apply

= Disconnected ’_|

Fig.93: Changing the network settings of the gateway

» Close the connection between host PC and gateway
» Close PACTware™

» NOTICE! IP20 (BL20) or IP67 (BL67) protection is not provided when the cover is opened over
the rotary coding switches. Device damage through penetrating foreign objects or liquids is

possible. Close the cover tightly above the rotary coding switches.
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7.2.5

Addressing gateways via a web server (PGM mode and PGM-DHCP mode)

» Connect the gateway to a host PC via the Ethernet interface.
» Open a web browser.

» Enter “http:\\192.168.1.254" in the address field of the browser.
» Log onto the gateway with the default password “password”.

A 1http:f,’]92.lﬂ!.l.'bﬂ!homr*m\

R~ B X | Home

Datei  Bearbeiten  Ansicht
% @jKonvertieren v [ Auswahlen

3 & Vorgeschlagene Sites + & Web Slice-Katalog +

Favoriten Extras 7

S

BL67-GW-EN

Embedded Website of BL67 Modular I/0 Module

Home >

Home

Gateway Diagnostics
Ethernet Statistics
Links

90

Gateway Information

Type BL67-GW-EN
Identificaton Number

6827214
Firmware Revision V3.0.3.0
Bootloader Revision Vv7.1.0.0
EtherMet/IP Revision V2.5.0.0
PROFINET Revision v1.1.7.0
Modbus TCP Revision V1.2.0.0
Rotary Switch Mode PGM

PROFINET Station Name

Network Settings

IP Address 192.168.1.254
Netmask 255.255.255.0
Default Gateway 192.168.1.1
MAC Address

00:07:46:02:1c:5d
LLDP MAC Address 1 00:07:46:02: 1c:5¢

LLDP MAC Address 2 00:07:46:02:1c:5¢

EtherNet/IP Status

Netwaork topology Linear
DLR State Normal
QuickConnect Disabled

For comments or questions, please email TURCK Support
URL http://wem.turck.com * Revision V1.0.0.0

Fig. 94: Logging into the gateway — Start page (Example: BL67 gateway)

NOTE
The password can be changed after the login via the web server.
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Addressing gateways

» Change the network settings via Network Configuration
» Confirm your changes with the Submit button.

™ hitp://192.168.1.254/network config. O v B & X || = Network Configuration X i

Datei Bearbeiten Ansicht Favoriten Extras 7

3 &Konvertieren ~ [ Auswahlen
»

3 a Vorgeschlagene Sites + a Web Slice-Katalog = ﬁ = Tl @ = Seite v Sicherheit v Extras v @'
BL67-GW-EN g
Embedded Website of BL67 Modular I/0 Module s
admin-user@192.168.1.55 [Logout] e
Network Configuration >
Home
Network Configuration Network Settings
Gateway Configuration IP Add
Gateway Diagnostics £ES8 192.168.1.254
Ethkemet Statistics Netmask 955955 2550
INKS

Change Admin Password Default Gateway 19216811

MAC Address 00:07:46:02:1c:5d

LLDP MAC Address 1 00:07:46:02:1c:58

LLDP MAC Address 2 00:07:46:02:1c:5F

Submit__|[  Reset

For comments or questions, please email TURCK Support
URL htto://wwar.turck.com * Revision V1.0.0.0

Fig.95: Changing network settings via the web server (example: BL67 gateway)
726  Resetting the gateway address to the default settings
> Set the rotary coding switches to 000 (Standard gateways) or set all DIP switches to position 0

(ECO gateways).
» Carry out a voltage reset.

7.2.7  Changing addressing mode

> Set the rotary coding switches (Standard gateways) or set the DIP switches (ECO gateways) to
the position for the required mode.
» Carry out a voltage reset.

7.2.8  Reading electronic modules

The electronic modules must be read in order to accept their arrangement in the gateway.
» BL20 gateways and BL67 gateways: Press the SET button for approx. 10's.
» BL20-ECO gateways: Set the CFG DIP switch to ON.

¢
!

ADDRESS

N,
o

Fig. 96: SET button (left BL20, middle BL67), CFG DIP switch CFG (BL 20-ECO gateways, right)

2015/11 91

BL ident® RFID Systems — Commissioning



Commissioning

7.3 Connecting the BL ident® system to a Modbus TCP master (example)

The following example describes the connection of BL ident® interface sets to a Modbus master
with the CODESYS programming software. The VT250-57P HMI is used as the Modbus master.
For connection the system must be defined with a Modbus master and BL ident® interface set
(Modbus slave), the Modbus channels defined and the required program for controlling the
RFID program loaded into the Modbus master.

Hardware used

The following hardware components are used in this example:
VT250-57P HMI, VT250-57P-L7-DPM FIRMWARE
BL ident® interface set TI-BL67-EN-S-2 with
BL67-GW-EN gateway (IP address 192.168.1.12) as Modbus TCP slave
1 x BL67-2RFID-S RFID module
TN-Q80-H1147 HF read/write head

Software used

This example uses the following software:
CODESYS 3.5 SP 1 Hotfix 1
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Connecting the BL ident® system to a Modbus TCP master (example)

7.3.1  Configuring the network and programming the Modbus master (VT250) with CODESYS

» Launch CODESYS.

7.3.2  Changing feature sets

3

L=

Fig. 97: Changing feature sets

Options

In this example CODESYS is run with the Professional feature set. This setting extends the range
of CODESYS functions.

» Choose Tools > Options... > Features.

» In the Predefined Feature Sets window choose the Professional setting.

ﬁ CoDeSys 2.3 converter

‘p Dedaration editor Visualization styles il
m Device editor [[] Enable simplified visualization styles handling

’
@ FBD, LD and IL editd Predefined Feature _ g

N~ FDT options

Please select a feature setthat best fits your needs:

4 Features

@ International Setting | |Professional 'l
m Libraries Description:

& Load and Save Recommended for users with advanced requirements. All features

are available, and some user interface aspects show maore complexity

PLCopenxML
& P in orderto unveil all possibilities of the system.

SFC
SFC editor

=] smartCoding
&= Syntax Highlighting

Text editor I
@ Visualization

@ Visualization styles

Cancel

Predefined feature sets... |

ok || Cancel
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7.3.3  Creating a new project in CODESYS

» Create a new project in CODESYS via File > New Project...

File | Edit Wiew Project Build Onl

|51 NewProject..  Ctrl+N
= oOpenProject... Ctrl40

Close Project

Save Project Ctrl+5
Save Project As...

Project Archive 3
Source upload...

Source download. ..

Print...

Page Setup...

Recent projects 3

Exit Alt+F4

Fig.98: Creating a new project

= This opens the New Project dialog.

» Choose the Standard project template.

» Give the project a name.

» Define a memory location for the project.

'-‘@ New Project

Categories: Templates:
Ej Libraries e
1 Projects ﬁ

Empty project Standard project

Standard project with
Application Compaser

A project containing one device, one application, and an empty implementation for PLC_PRG

Name: VT250_Modbus_Master
Location:  D:'Projekte\ModbusTCP - E]

OK | ’ Cancel ]

Fig. 99: Defining a standard project
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Connecting the BL ident® system to a Modbus TCP master (example)

= This opens the Standard Project dialog.
» Choose the Turck VT250-57x (Hans Turck GmbH & Co. KG) used as a device
» Select the preferred programming language for the central program block PLC_PRG. The fol-
lowing programming languages can be selected:
Sequential function chart (SFC)
Instruction list (IL)
Continuous function chart (CFC)
Function block diagram (FBD)
Ladder diagram (LD)
Structured text (ST)

-
Standard Project
’ You are about to create a new standard project. This wizard will create the following

- objects within this project:
y ﬂ

- One programmable device as specified below

- Aprogram PLC_PRG in thelanguage specified below

- A cyclic task which calls PLC_PRG every 20 milliseconds

- A reference to the newest version of the Standard library currently installed.

Device: ITurck WT250-57% (Hans Turck GmbH & Co. KG) 'J
PLC_PRG in: IConﬁnuous Function Chart (CFC) YJ
[ oK ] I Cancel I |

[ ]

Fig. 100: Standard project dialog - Selecting the device and programming language

= The new project is created.
= The project tree in CODESYS is as follows:

File Edit View Project Build Onlne Debug Tt
He E o4 4
Devices
=13 VT250 Modbus_Master
=& pevice (Turck vT250-57%)
=Bl PLC Logic
=-1Ck appl
m Library Manager
PLC_PRG (PRG)
= @ Task Configuration
@ MainTask

Fig. 101: Project tree in CODESYS

ﬂ NOTE
You can show the Devices window via View > Devices.

95

BL ident® RFID Systems — Commissioning



Commissioning

734  Defining communication settings

The communication path (gateway) to the VT250-57x Modbus master is defined via the Com-
munication Settings tab.

NOTE
ﬂ The VT250-57x Modbus master and the PC on which CODESYS is installed, must be
stations of the same Ethernet network. Otherwise no communication is possible.

» Click 2 x on Device (Turck VT250-57x) in the project tree.

= This opens the editor for the device.

» Choose the Communication Settings tab.

» Click Add Gateway...

= This opens the Gateway dialog.

» If desired assign a new gateway name.

» Define an IP address for the gateway or leave it on the setting “localhost”.

= The “localhost” setting defines the local CODESYS communication gateway of the PC as the
programming interface.

i Gateway ﬁ1

Name: Gateway-1

Driver: TCR/IP 'J

IP-Address localhost
Part 1217

The setting 'IP-Address’ can be used to specify an IPAddress for the
gateway. This is useful if you want to connect to a remote gateway running
on another PC ar device.

By default, this setting is localhost’ to directly connect to the gateway on
your PC.

[= 4

Fig. 102: Defining communication settings
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7.3.5  Setting the communication path

> Select the gateway.

» Click the Scan network button.

= This finds the connected VT250-57x
» Select the VT250-57x.

» Click the Set active path button

Select the network path to the contraller:

Gateway-1:0301.B018.8000.0A53.A0FD

E--*, Gateway-1
|wr250-57x-L7-PNM [0301.801B.8000.0A53.A0FD] (active) |

Node Hame:
WT250-57x-L7-PNM

Node Address:
0301.B01B.8000.0A53.A0FD

Target ID:
16#10070020

Target Name:
Turck VT250-57x

Target Type:
1621000

Target Vendor:

Hans Turck GmbH & Co. KG

Target Version:
3.5.1.0

Don't save network path in project

Fig. 103: Setting the communication path
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Filter :

|

Sorting order :

|
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7.3.6  Renaming the application

The rcX operating system requires file names to comply with the 8.3 naming convention. The
name of the file saved in the device must therefore consist of no more than 8 letters or digits, a
period and no more than 3 characters.

» Right-click Application in the project tree to open the context menu.

» Select Properties.

» In the Common tab assign a name for the application that is no more than 7 characters long
(here: APPL).

» Confirm your entry with OK.

NOTE
You can skip this step if you are using CODESYS 3.5 or a higher version.

NOTE
An application name that does not comply with the naming convention may cause
data loss and communication problems between PC and VT250.

lenifis
Fle Edt Vew Project Buld Onine Debug Tooks Window Help

B dlS 48R - (7 IR 08

Devices >~ % X | ] StrtPage /[f) Device

=) VT250 Modbus Master
== pevice (Turck vT250-57%)
=B pLC Logic
=k Appl
i Library Manager
PLC_PRG (PRG)

Communication Settings | Applications | Log | PLC settings |, Task deployment [ status |

Select the network path to the controller:
Gateway-1:0301,8015,8000.0453. AOFD

= fyg Gateway-1
[fl ¥T250-57x-17-PNM [0301.B01B.8000.0A53. A0FD] (active)

Hode Name:
VT250-57x-L7-PNI

= {8 Task Configuration
B MainTask Node Address:

I0301.B018.8000./

Target ID:
16#10070020

= Target Name:

Properties - Appl [Device: PLC Logic] Turck vT250-57

Commen | Application build options | Buid | Boot application | Access cont * | * I;’:‘*}DESUT""E:

Target Vendor:
o IHans Turck GmbH
>

Appl
Target version:

3.5.1.0

Fullname:  Appl [Device: PLC Logic]

Object type:  Appiication

Open with:
[] Don't save netwark path in project
[ Secure online mode
Cross Reference List ~ I X | Messages
Name: -] % =& Scope: -
POU  Variable Access Type Scope  Address  Location  Comment Descriptio

<

Precompile:

[ FOUs | 32 Devices

Fig. 104: Renaming the application

» Confirm the subsequent warning prompt with “Yes”
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7.3.7

Connecting the BL ident® system to a Modbus TCP master (example)

Adding an Ethernet adapter

» Right-click Device (Turck VT250-57x) in the project tree to open the context menu.

» Click Add device... in the context menu.

= This opens the Add device dialog.

» Choose Fieldbuses > Ethernet Adapter to select the Ethernet Adapter of 3S - Smart Software
Solutions GmbH.

» Close the Add device dialog.

= The Ethernet adapter appears in the project tree.

I I
B StartPage Device
2 — o
) e 00 v =
Sel Name: Ethernet
G; Action:
= @ Appenddevice (O) Insert device (©) Plug device () Updatedevice
Device:
vendor: [<MI vendors: i
Name Vendor Wersion
+. [0 Miscellaneous

= [ Fieldbusses
+.-cAN CANbus
= HE Ethernet Adapter
@ 35 - Smart Software Solutions GmbH ~ 3.5.7.0
4. == EthernetIP
+--0et5 Modbus
4. 5 Profibus

+ Profinet 10

[] Display all versions (for experts only) [] Display outdated versions

Information:

m Name: Ethernet
Vendor: 35 - Smart Software Solutions GmbH
Categories: Ethernet Adapter

Version: 3.5.7.0

Order Number: - %

Description: Ethernet Link. —
h

Append selected device as last child of
Device

&  (You can select another target node inthe navigator while this window is open.)

Add Device ] [ Close

Froce Dafaranca lict

Fig. 105: Adding the Ethernet adapter as the device
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738  Defining a V1250 HMI as the Modbus master

» Right-click Ethernet in the project tree to open the context menu.
» Click Add device... in the context menu.

= This opens the Add device dialog.

» Choose the Modbus TCP master.

» Close the Add device dialog.

= The Modbus TCP master appears in the project tree.

x ] startPage ' | Device
T N
[ [ Add Device =
Commu O —
Seld Name: Modbus_TCP_Master
Gat| Action:
=1 @ Append device () Insert device (O) Plug device () Update device N
Device:
Vendor: [cml vendors > M
Mame Vendor Version
=0 Fieldbusses
+. = EthernetIP
=5 Modbus
= M EL
@ Modbus TCPMaster 35 - Smart Software Solutions GmbH 3.5.6.0 I
[ Modbus TCFMaster netX  Hilscher Gesellschaft fur Systemautomation mbH  3.3.1.0
+- s ModbusTCP Slave Device
Profinet 10
[] Display all versions(for experts anly) [] Display outdated versions
Information:
m Name: Modbus TCP Master
Vendor: 35 - Smart Software Solutions GmbH
Categories: Modbus TCP Master
Version: 3.5.6.0
Order Number: - =
Description: A device that works as a Modbus Master on Ethernet, B> o
Append selected device as last child of
Ethernet
&  (You can select another target node inthe navigator while this window is open.)
= Add Device ] [ Close
—
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Fig. 106: Appending the Modbus master as the device
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Connecting the BL ident® system to a Modbus TCP master (example)

739  Adding a Modbus TCP slave

» Right-click Modbus TCP (Modbus TCP master) in the project tree to open the context menu.
» Click Add device... in the context menu.

= This opens the Add device dialog.

» Choose the Modbus TCP slave.

> Repeat the process according to the number of Modbus TCP slaves.

» Close the Add device dialog.

= The Modbus TCP slaves appear in the project tree.

Jdi L Faye IJJ e
3 [ sz "
[ Add Device
el L N ]
Mame: Modbus_TCP_Slave
Action:
@ Appenddevice (7 Insert device () Plug device (7) Update device
Device:
Vendor: [<AII vendors > i
MName Vendor Version
= ﬁ Fieldbusses
=0 Modbus
=-Weti Modbus TCP Slave
[ Modbus TCPSlave 35 - Smart Software Solutions GmbH ~ 3.5.7.0

[ Display all versions(for experts only) [7] Display outdated versions
Information:
m Names: Modbus TCP Slave

Vendeor: 35 - Smart Software Solutions GmbH

Categories: Modbus TCP Slave

Version: 3.5.7.0

Order Number: -

Description: A generic Modbus device that is configured as Slave for a Modbus TCP Master. P —
Append selected device as last child of
Modbus_TCP_Master
#  (You can select another target node inthe navigatar while this window is open.)

Add Device ] [ Close

Fig. 107: Adding the Modbus TCP slaves as devices
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» Rename the Modbus TCP slaves if required. (right-click on the Modbus TCP slaves in the Proj-
ect tree > Properties)

Properties - Modbus_TCP_Slave [Device: Ethernet: Modbus_TCP_Mast... 22

Common | Build |Access control

i BLE7_GW_EN
Full name: Modbus_TCP_Slave [Device: Ethernet: Modbus_TCP_Master
Object type:  Device

Open with: Device Editor

Fig. 108: Renaming Modbus TCP slavesClick the entry of the Modbus TCP slave 2 X in the proj-
ect tree.

= This opens the associated editors.
» In the Modbus TCP slave tab enter the IP address (in the example: 192.168.1.12). All other set-

tings can be retained.

Fle Edt View FProject Buld Onine Debug Took Window Help
o a7 e o
S ] # O | i | 0§
Devices v 8 X | " Startpage Device (] BL67_GW_EN
=G V7250 Modbus Master >
=[5 Device (Turck \T250-57%) ModbusTCP Slave | Modbus Slave Channel | Modbus Slave Init. | ModbusTCPSlave Configuration | MedbusTCPSlave 1o Mapping | Status [1
=0 PLCLoge Modbus-TCP
= 2 Appl M us
i) Library Manager Slave TP Address: 192,168 . 0 . 1
PLC_PRG (PRG) Unit-ID [1..247)
= (# Task Configuration
& MarTask Response Timeout (ms) 1000
Port 502

=4 Ethemet [Ethernet)
= m Modbus_TCP_Master (Modbus TCP Master)
BLE7_GW_EN (Madbus TCP Slave)

Fig. 109: Changing the IP address of the Modbus TCP slave
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Connecting the BL ident® system to a Modbus TCP master (example)

7.3.10 Modbus channels: Adding mapping

Modbus TCP master (here: VT250) and Modbus TCP slaves (here: BL67-GW-EN) communicate
via defined Modbus channels. The Modbus channels are defined via the following parameters:
Access type: Modbus function code which defines access type and method (bitwise or word-
wise, read or write).
READ Register > Offset or WRITE Register > Offset: Start address of the registers of the
Modbus slave to be read or written. The register addresses are provided, for example, in the
PACTware™ station report. The following start addresses apply to the gateways:

Offset
Gateway

READ register WRITE register
BL20/67-PG-... 0x4000 0x4400
BL20/67-GW... 0x0000 0x0800
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The start addresses for the channels of the BLxx-2RFID-S modules are provided in the following

table:
Input Byte Bit 7 Bit 6 Bit5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Channel0 n DONE BUSY ERROR XCVRCON  XCVRON TP TFR Reserved
n+1 Error Code

n+2 Error Code 1

n+3 Reserved
n+4 READ DATA (8 bytes)
n+5
n+10
n+11
Channel 1 n+12 DONE BUSY ERROR XCVRCON XCVRON TP TFR Reserved

n+13 Error Code

n+14  Error Code 1

n+15  Reserved
n+16  READ DATA (8 bytes)

n+17
n+22
n+23
Output Byte Bit 7 Bit 6 Bit5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Channel0 m XCVR NEXT TAGID READ WRITE TAG INFO XCVR RESET
INFO
m+1 Error Code Byte Byte Byte

Count 2 Count 1 Count 0

m+2 Address high byte

m+3 Address low byte
m+4 WRITE DATA (8 Byte)

m+5
m+10
m+11
Channel1 m+12 XCVR NEXT TAGID READ WRITE TAG INFO XCVR RESET
INFO
m+13  Reserved Byte Byte Byte

Count 2 Count 1 Count 0

m-+14  Address high byte

m+15  Address low byte
m+16  WRITE DATA (8 Byte)
m+17

m+22

m+23
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Connecting the BL ident® system to a Modbus TCP master (example)

7.3.11  Setting up Modbus channels
Setting up Modbus channel 1 (READ register)

» Double-click the Modbus TCP slave in the project tree.

» Select the Modbus Slave Channel tab.

» Click the Add Channel... button

» Select the Read Holding Registers (function code 03) access type.

» Enter under Offset the start address of the register to be read (here: 0x0000).
» Enter the length of the register to be read (max. 14).

» Confirm your entries with OK

Froject [wd Crine Debog  Toos Window e

fle  [de
N H| & R 0 | o
| Letvices > 32X Bl swieage [ Dewe ] mar_aw_tn
i T Modu, paster Bl
= B3 Device (Turdk VT290:57:) ModbusTir Slave | Mexben Save Cluwed | odbus slave ind | Modbusitrsiave tonfigaraton | Modbusitrsiave 140 Magong | Stans | infoomason
= bl mcLoge Mame  AccessType  Trgner  READ Offset  Length  EmorHanding  WEITEOHfset  Length  Comment
0 napt

Ml Loeary manager

B mC_PrG Pac)

Y Tk Corfigur ation

& manmask
= Ethemet (Ethemed) MedbusChannel
T Modtns_TCP_Mastes (Modbus TCP Magter] f -

3 wer_ew_En (Modbus TOP Slave) Channel
Hame Channed 1
Mccess Type Readd rikdng Regeters (Funcion Code 3) -
Teigger e w! Cpede Time (=3} 100
Comment
READ Regster
Offset D000 -
Lesglh "
Errur Handling | Kinep Last Vi -
WRITE Regster
Offust
Length

[ o« Cangel.

Add Channel_ | t

Fig. 110: Setting up a Modbus channel (READ register) — Example
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Setting up Modbus channel 2 (WRITE register)

» Double-click the Modbus TCP slave in the project tree.

» Select the Modbus Slave Channel tab.

» Click the Add Channel... button

» Select the Write Holding Registers (function code 16) access type.

» Enter under Offset the start address of the register to be written (here: 0x0800).
» Enter the length of the register to be read (max. 14).

» Confirm your entries with OK.

= 8 X | [ swtPaoe [ F] Dever | 5 GU67_GW_EN

ModusTCR Slave | Modbus Slave Charned | Modbus Slave It | MedbusTCPSlave Configuranon | MedbusTCPSlave 1O Mapong | St | Informaten

8 P Loge Mame  fecess Type  Toggee  READ Offeel  Length  Freos Handlng — WRITE Olfset  Lenglh  Comment
)
"‘.?" Che_ ResdMoldng. CYCLIC . 1620000 1" Keep last Value
Lbrary Manager
1B e pac s
&8 Tas Consguranon

= [ Modbus _TCP Master (Modbus TCP Master)
T 267 GW_EN (Modbus TOP Slave)

| ModbusChannel

Charrel
Hime Channel 2

Vinins Matoes Regaters (Funcen Cade 46) -

erekc «| CyceTimems) 00
READ Regater
e

E00 =
“ 4

ok | [ comeel

[ Add Ghwanel.. oel

Fig. 111: Setting up a Modbus channel (WRITE register) — Example
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Connecting the BL ident® system to a Modbus TCP master (example)

7.3.12 Updating variables

» Select the Modbus TCPSlave I/0 Mapping tab.
» Mark the Always update variables check box.

[l Stwthage |5 Dever | 5] BLGTONFN ' Modbes TCP_Master

HodewsTCP Master Condiguraton | ModbusTURMastir 10 Msond | ModewsTCPMaster Condguraton | Stans | informaten
Channels

Variakle Mapping  Channel  Addeess  Type Default Value  Unit  Deseription

Fig. 112: Updating variables
7.3.13  Creating a program

» Create your application specific program
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7.3.14 Loading the project in the Modbus TCP master VT250-57x

» Click Build > Recompile.

» Log into the device via Online > Login.

= The CODESYS project is loaded into the VT250-57x.
» Start the program via Debug > Start.

= The program runs.

¢ B few Poect Bid Qriee Deg Jooh findew e
IE A @ DX MG T E S, el

[ st 1@ e 3 ez oW | Eeeet | botun T i | =

@ T | Metam T | ModaTCITve 1 Maporg | suanes [ informaton

Charnria

Varistile Mippng  Channel  Address  Type Current Value  Fiep unt  Description
Chanel 1 WIWD  WORD READ 1647030 (+30000)
Chanel 3 WIWE  WORD READ 690081 (=30001) « Oefadt
Chennel s %W WORD READ 16m3002 (~20802)
Casrels  mE3 womD RESD 1629003 (m10503)
Channel ] WIWA WORD BELD 184800 (=30004)

5 () Mot TEP Manter (Mostas TOP Hanter} el WOWS WORD READ 163085 (w30205] « Dwfait Text in erven
@ mnr o B (e YO sl Chanel 1 WENG WORD READ 1699006 (=40506)

Channel 1 wiWT  WORD READ m(-mm
Chemnell MWD WORD RELD 1620008 (=30008)
Channel 3 bWl woRD BEAD 184300 (=2000%)

Chanalt WD woRD
thennel 1 WMWLL WORD
Chennel L WIWI2 WORD
Chamnel ] %IWID WORD

P e S i R e

LSRR S I R TR A I R AR S R TR SR R AR I R
seSbessssenessaanesnaysssesy

SEAD 1623084 [=03020)
READ 1620008 (02011}
FEAD 16590IC (<1013}
READ 1643000 (=20013)

Fig. 113: Loading the project in the VT250-57x

Channell  WQWS WORD WAITE 1802800 (m03048)
Chianel 2 WQWL WORD WRITE 1629001 (62045}
Channell  WQWZ WORD WRITE 1665812 {02050}
Chennel?  HOWD WORD WRITE 1550803 (~32051]
Chinel 2 WOW WORD WRITE 142244 (m32082)
Chinel  HQWE WORD WRITE 1608035 (~02083)
cheanel 2 WOWE WORD. WRITE 1620806 {m02084)
Cemnelz  ROWT WORD WRITE 1523807 (m02055)
Channel 2 WOWE WORD. WAITE 150188 {=32056)
Chimnelz  WEe womo WRITE 1522404 (=02087)
(Channel2 QW WORD WRITE 16w 04t (=02054)
| Channel 2 WOW_ WORD WRITE 1620808 (=02055)
Channei2 QW WORD WRITE 1652805 [-03063)
Chinesl 2 WGW. WORD WRITE 1622800 (m02081)
Fastt MIOETG 1] Abwars ssdate vartablen
TEC Objects
Variakle Migping  Type
& BLELOWEN ‘¢ MadbusTCPSae
vy st b
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Connecting the BL ident® system to a Modbus TCP master (example)

7.3.15 Reading out process data

The process data is displayed in the Modbus TCP Slave I/0 Mapping tab. The following figure
shows that the status bit XCVR_CON is set on the both input bits 0.4 and 12.4. The status bit
DONE is set on the input bits 0.7 and 12.7.

Bt Pew Poiect Badd Qine Debug ook fifedow  Heo

=l & L Jigh o ) .
| > B X fg] Stifege |[§) Devee () LbraryMenager ] PLCPRG.F] BLGT_GW_EN [ Etemet | §] Mok T Maser
VTZS Moctus._ Master x|
5 Device [connectad] (Turck ¥T250-57%) b it | Madbus s | Mot int | Madk aaret Lar Mok TCPSlave 110 Mapping | Seans | ekermation
= 3l mcLoge Chamnels
= £ appl [run] Viariskde Mapping  Channel  Addieis  Type Diefalt Wahse  Cuerent Vahue  Prepared Value  Unit  Deteription
ml-"!w . Channel 1 WD WORD - READ 1£80030 (=D3020)

s [

nto HOD BOOL
8it | EOOL
(3] 2
83

3 ethemet Fhemet)
) Metun TP Mamter (Mexins TCR Master]
3 re7 W _EN (Mochus TCP Save)

LS S e SR R I A O AL R R AL

Dit 1%

Channel 1
Channgl 1
Channel 1
Channel 1
Channg! 1

*e 0o e

A R R Y

Fig. 114: Reading out process data
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3 Setting and parameterization
8.1 BLxx-2RFID-S — Process input data

8.1.1  Process input data in HF applications

NOTE

ﬂ The I/0 mapping of the BL ident® interface must match up with the configuration of
the entire BLxx station: Any other I/O modules fitted (not BLxx-2RFID-S) must be taken
into account if they are located in front of the BLxx-2RFID-S modules.

Byte no. Bit
7 6 5 4 3 2 1 0
0 DONE BUSY ERROR XCVR_CON XCVR_.ON TP TFR res.
1 Error code (2 bytes) LSB
2 MSB
3 res. res. res. res. res. res. res. res.
4 8 bytes read data (READ_DATA)
5
6
7
8
9

—_ | =
- | o

110 Hans Turck GmbH & Co. KG | T +49 208 4952-0 | F +49 208 4952-264 | more@turck.com | www.turck.com



BLxx-2RFID-S — Process input data

8.1.2  Meaning of the status bits in HF applications

The following table explains the status bits of the process input data:

Designation Meaning

DONE 1: The system is not currently processing a command and is ready to receive a subsequent command.
0: All incoming commands are ignored apart from the RESET command. DONE only switches to 1 if all
command bits (READ,WRITE ..) are 0

BUSY 1: The system is currently executing a command.

0: The command execution was completed.
BUSY is not the inversion of DONE and in certain circumstances cannot be used with a handshake pro-
cedure. To set up a handshake procedure use the variable DONE.

ERROR 1: An error occurred, during command execution. If this flag follows a write command (WRITE), for
example, the data of the send buffer was not written to the tag. If this flag follows a read command, no
data was read from the tag and no new data was loaded into the receive buffer.
0: The last write or read command could be executed successfully. The receive buffer contains valid data.
Detailed information is supplied via the error code (2 bytes).

XCVR_CON 1: The read/write head is correctly connected on the BLxx-2RFID-S module.
0: The read/write head is not correctly connected on the BLxx-2RFID-S module.

XCVR_ON 1: The transmission at 13.56 MHz between read/write head and tag is active.

0: The transmission at 13.56 MHz between read/write head and tag is not active.

TP (Tag Present)

1: Atag is in the sensing range of the read/write head and is detected by it.
0:There is no tag in the sensing range of the read/write head or the read/write head has not detected it.

TFR (Tag fully read)

1: All data areas of the tag were completely read by the BL ident® system and the tag is still in the sens-
ing range (TP=1). This automatic reading always takes place when there is a tag in the sensing range of
the read/write head. The time between TP=1 and TFR=1 cannot be regarded as the reference time for a
read and write command. If only a few bytes are read or written with a read or write command, the com-
mand is executed considerably faster than, for example, the complete reading of a 2000 byte tag. With
TFR=1, read commands can directly access data already stored.

0: Data areas of the tag were not yet completely read by the BL ident® system or the tag is not in the
sensing range of the read/write head.

This automatic read operation is interrupted by all user commands, the TFR bit retains its actual value.
The operation is restarted if no other commands are pending and TP=1.

2015/11

NOTE
ﬂ Depending on the system, the BUSY status bit cannot be used in many cases for a
handshake procedure. To set up a handshake procedure use the DONE status bit.
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8.1.3  Process input data in UHF applications

NOTE

ﬂ The I/0 mapping of the BL ident® interface must match the configuration of the sta-
tion: Any other I/0 modaules fitted (not BLxx-2RFID-S) must be taken into account if
they are located in front of the BLxx-2RFID-S modules.

Byte no. Bit
7 6 5 4 3 2 1 0
0 DONE BUSY ERROR XCVR_CON XCVR_.ON TP - res.
1 Error code (2 bytes) LSB
2 MSB
3 res. res. res. res. res. res. res. res.
4 8 bytes read data (READ_DATA)
5
6
7
8
9

—_ | =
- | O
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BLxx-2RFID-S — Process input data

8.14  Meaning of the status bits in UHF applications

The following table explains the status bits of the process input data:

Designation Meaning

DONE 1: The system is not currently processing a command and is ready to receive a subsequent command.
0: All incoming commands are ignored apart from the RESET command. DONE only switches to 1 if all
command bits (READ,WRITE ..) are 0

BUSY 1: The system is currently executing a command.

0: The command execution was completed.
BUSY is not the inversion of DONE and in certain circumstances cannot be used with a handshake pro-
cedure. To set up a handshake procedure use the variable DONE.

ERROR 1: An error occurred, during command execution. If this flag follows a write command (WRITE), for
example, the data of the send buffer was not written to the tag. If this flag follows a read command, no
data was read from the tag and no new data was loaded into the receive buffer.
0: The last write or read command could be executed successfully. The receive buffer contains valid data.
Detailed information is supplied via the error code (2 bytes).

XCVR_CON 1: The read/write head is correctly connected on the BLxx-2RFID-S module.
0: The read/write head is not correctly connected on the BLxx-2RFID-S module.

XCVR_ON 1: The UHF radio field of the read/write head is active.

0: The UHF radio field of the read/write head is not active.

TP (Tag Present)

1: Atag is in the sensing range of the read/write head and is detected by it.
0:There is no tag in the sensing range of the read/write head or the read/write head has not detected it.

ERROR_CODE_O0...1

Representation of the error code - Array of length 2 bytes.
The error code 0202 is output when multiple tags are detected

READ_DATA

Read data - Array of length 8 bytes.
The read data (can also have information from the tag and about the UHF radio field).

2015/11

NOTE
ﬂ Depending on the system, the BUSY status bit cannot be used in many cases for a
handshake procedure. To set up a handshake procedure use the DONE status bit.
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8.2  BLxx-2RFID-S module — Process output data

82.1  Process output data in HF applications

Byte no. Bit

7 6 5 4 3 2 1 0
0 XCVR NEXT TAG_ID READ WRITE TAG_INFO XCVR_INFO RESET
1 GET res. res. res. res. Byte_Count2 Byte_Count1 Byte_CountO
2 MSB AddrHi LSB
3 MSB AddrLo LSB
4 8 bytes write data (WRITE_DATA)
5
6
7
8
9
10

—_
—_

822  Meaning of the status bits in HF applications

NOTE

ﬂ The BLxx-2RFID-S module generates an error message if more than one command bit
is set of TAG_ID, READ, WRITE, XCVR_INFO or TAG_INFO! Bit XCVR must always be set
for the execution of a command in order for the read/write head to stay active.

The following table shows the meaning of the command bits of the above process output data.
The flow charts for the commands are provided in the Appendix:

Designation Meaning

XCVR 1: The read/write head is activated (signal transmission at 13.56 MHz).
0: The read/write head is deactivated (no signal transmission).
If XCVR = 0 while the BL ident® system is processing the execution of a command, the command is not
executed until the end. The read/write head is then not deactivated until the status bit DONE = 1.

NEXT 1: Exactly one command can be executed with the same tag. If another command is initiated with the
same tag, the BUSY status bit = 1. The BL ident® system must be reset (RESET) or the command must be
executed with a different tag.

0: Function is not used.

TAG_ID 0 > 1:The rising edge initiates the command for reading the UID. The command is executed if there is a
tag in the sensing range of the read/write head.
0: Function is not used.

READ 0 > 1:The rising edge initiates the read command. The command is executed if there is a tag in the sens-
ing range of the read/write head. The byte number ByteCount0..ByteCount2 is read from the tag address
AddrLo, AddrHi.
0: Function is not used.
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BLxx-2RFID-S module — Process output data

Designation Meaning

WRITE 0 = 1:The rising edge initiates the write command. The command is executed if there is a tag in the sens-
ing range of the read/write head. The byte number ByteCount0..ByteCount2 is written to the tag address
AddrLo, AddrHi.

0: Function is not used.

TAG_INFO 0 > 1:The rising edge initiates the command TAG_INFO (information on the tag). The command is ex-
ecuted if there is a tag in the sensing range of the read/write head. The information on the tag in the read
data area is sent with the process input data with the following 8 bytes:

Byte 0: Number of blocks -1 of the tag (i.e. 27 -> 28 = blocks)

Byte 1: Number of bytes 1 per block (i.e. 3 = 4 bytes per block)

Byte 2: Not supported (DSFID - tag format)

Byte 3: Not supported (AFI — application ID)

Byte 4: Not supported (ICID - not supported) - IC code (not supported) byte 5 to byte 7:,0"
0: Function is not used.

XCVR_INFO 0 > 1:The rising edge initiates and executes the command XCVR_INFO (information on the read/write
head). The information on the read/write head is sent in the read data area with 8 bytes with the process
input data. The information content can be configured. The information content is selected with AddrHi,
AddrLo.
00FO0},,: The first 8 bytes of the ORDER_ID (here: product designation) are sent, e.g. TNER-Q80 = 54 4E 45
522D 51 38 30 pe (ASClI table)
00F 1, The second 8 bytes of the ORDER_ID (here: product designation) are sent, e.g.:-H1147\0\0 = 2D 48
31313437 5C00 5C 00y, 00F2,.,: The third 8 bytes of the ORDER_ID (here: product designation) are sent.
00F3,,,: The fourth 8 bytes of the ORDER_ID (here: product designation) are sent.
00F4,o,: The hardware and firmware versions of the read/write head are sent.

Byte 0: Part x of the hardware version x.y.

Byte 1: Part y of the hardware version x.y.

Byte 2: Letter V = 56, of the firmware version Vx.y.z.
Byte 3: Part x of the firmware version Vx.y.z.

Byte 4: Part y of the firmware version Vx.y.z.

Byte 5: Part z of the firmware version Vx.y.z.

Byte 6 to byte 7:is not used.

RESET 0 - 1:The rising edge causes a Reset of the BL ident® system. If the status bit BUSY is set, the execution
of the current command is aborted and the status bit DONE is set. The status bit ERROR and the two error
message bytes (error code) of the process input data are deleted.

GET 0 - 1:Therising edge initiates the GET command. The GET command enables tags to be protected with a

password. For this the GET command contains the following commands:

- Set tag PWD (start address 4)

- Set transceiver PWD (start address 5)

- Reset transceiver PWD (start address 6)

- Set tag protection (start address 7)

- Get tag protection status (start address 9)

The start address of the command defines the function. Further information is provided in the chapter
Protecting tags with a password.

Byte_Count0...2

Number of bytes - 1; to be read (READ) or written (WRITE). 111 (7,,.,) = 8 bytes are to be read or written.

AddrHi, AddrLo

Array of length 2 bytes. Represents the start address of the memory area on the tag which is to be accessed
with the write or read command.

The writable/readable start addresses of the tags can be = 0.

The manual BL ident® HF systems — Engineering (D500024) provides information on the writable/readable
start address of the tag variants.

WRITE_DATA

Write data - Array of length 8 bytes.

2015/11
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823  BLxx-2RFID-S module — Process output data in UHF applications

Byte no. Bit
7 6 5 4 3 2 1 0
0 XCVR NEXT TAG_ID READ WRITE TAG_INFO XVCR_INFO RESET
1 res. res. Domain_ Domain_ res. Byte_ Byte_ Byte_
Count 1 Count 0 Count 2 Count 1 Count 0
2 MSB AddrHi LSB
3 MSB AddrLo LSB
4 8 bytes write data (WRITE_DATA)
5
6
7
8
9

—_ | =
[ N e
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824  BLxx-2RFID-S — Meaning of the status bits in UHF applications

NOTE
ﬂ The BLxx-2RFID-S module generates an error message if more than one command bit

is set of TAG_ID, READ, WRITE, XCVR_INFO or TAG_INFO! Bit XCVR must always be set
for the execution of a command in order for the read/write head to stay active! During
a read/write operation, the bits for Byte_Count, Domain_Count and the bytes for
AddrHi, AddrLo must always be set. The Domain_Count (Bit 4 and 5) must always be
set so that the address range of the tag is determined.

@ NOTICE
Incorrect writing to the tag

Possible malfunction of the tags!
» Proceed with care when writing to the reserved area (bank address = 00) or to the
first four bytes of the Ull memory (bank address = 01).

The following table shows the meaning of the command bits of the above process output data:

Designation Meaning

XCVR 1: The read/write head is activated.
0: The read/write head is deactivated (no signal transmission is taking place).
If XCVR = 0 while the BL ident® system is processing the execution of a command, the command is not
executed until the end. The read/write head is then not deactivated until the status bit DONE = 1.

NEXT 1: Exactly one command can be executed with the same tag. If another command is initiated with the
same tag, the BUSY status bit = 1. The BL ident® system must be reset (RESET) or the command must
be executed with a different tag.

0: Function is not used.

TAG_ID 0 > 1:The rising edge initiates the command for reading the UID. The command is executed if there is
atag in the sensing range of the read/write head.
0: Function is not used.

READ 0 > 1:The rising edge initiates the read command. The command is executed if there is a tag in the
sensing range of the read/write head. The byte number ByteCount0..ByteCount2 is read from the tag
address AddrLo, AddrHi.

0: Function is not used.

WRITE 0 - 1:Therising edge initiates the write command. The command is executed if there is a tag in the
sensing range of the read/write head. The byte number ByteCount0..ByteCount2 is written to the tag
address AddrLo, AddrHi.

0: Function is not used.
TAG_INFO 0 - 1:Therising edge initiates the command TAG_INFO (information on the tag). The command is

executed if there is a tag in the sensing range of the read/write head. The information on the tag in
the read data area is sent with the process input data with the following 8 bytes:

Byte 0: Number of blocks -1 of the tag (i.e. 27 = 28 blocks)

Byte 1: Number of bytes 1 per block (i.e. 3 = 4 bytes per block)

Byte 2: Not supported (DSFID - tag format)

Byte 3: Not supported (AFI — application ID)

Byte 4: Not supported (ICID - not supported) — IC code (not supported) byte 5 to byte 7:,0"

0: Function is not used.
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Designation Meaning

XCVR_INFO 0 > 1:The rising edge initiates and executes the command XCVR_INFO (information on the read/
write head). The information on the read/write head is sent in the read data area with 8 bytes with the
process input data. The information content can be configured. The information content is selected
with AddrHi, AddrLo.
00FO0},x: The first 8 bytes of the ORDER_ID (here: product designation) are sent.
00F 1,6, The second 8 bytes of the ORDER_ID (here: product designation) are sent.
00F2},¢,: The third 8 bytes of the ORDER_ID (here: product designation) are sent.
00F3},e,: The fourth 8 bytes of the ORDER_ID (here: product designation) are sent.

The following product designations have been implemented:
Type designation of the read/write head #ldent no.

RESET 0 - 1:Therising edge causes a Reset of the BL ident® system. If the status bit BUSY is set, the execu-
tion of the current command is aborted and the status bit DONE is set. The status bit ERROR and the
two error message bytes (error code) of the process input data are deleted.

Byte_Count0...2 Number of the bytes -1 that still have to be read (READ) or written (WRITE). 111 (7,,¢,) = 8 bytes are to
be read or written.

Domain_Count_0...1 Address areas of the UHF tag banks (domain):
00: Reserved area
01: UI/JEPC 1
0:TID
11: User area

AddrHi, AddrLo Array of length 2 bytes. Represents the start address of the memory area on the tag which is to be ac-
cessed with the write or read command.
The writable/readable start addresses of the tags can be = 0.
The manual BL ident® HF systems — Engineering (D500024) provides information on the writable/
readable start address of the tag variants.

WRITE_DATA Write data - Array of length 8 bytes.
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Testing BLxx-2RFID-S modules with the DTM

The 2RFID-S modules can be tested with the DTM (Device Type Manager) via PACTware™. The
functions of the DTM are displayed by right-clicking the RFID electronic modules in the project

tree.

You can start the following functions:

= Parameters: Adapt parameters to the actual application

= Measured values: display of the data read by the RFID electronic module

» Simulation: Output parameter of the RFID electronic module for the function test

= Diagnosis: display of the diagnostic message of the RFID electronic modules or the entire

RFID system

Device tag

B HOSTPC
== TCP:192.168.1.50
“E=7 192.168.1.254/BL67-GW-E

Disconnect

B Load from device
M1 Store to device

Parameter

Measured value
Simulation
Diagnosis

Print

Additional functions

Add device
Exchange device
B Delete device

&

Properties <01,01/BL67-2RFID-5=BL67-2RFID-5

Fig. 115: DTM - Functions of the BLxx-S modules
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8.3.1  BLxx-2RFID-S — Setting parameters

The following parameters can be set for each channel with the BLxx-2RFID-S modules:
Operating mode
UHF frequency band (only with UHF)
UHF transmission signal (only with UHF)
Bridging time
Data arrangement
Parameter set

» Establish the connection between host PC and BL ident® interface.
» Right-click the RFID electronic module.

» Choose Parameter > Parameterization or Online Parameterization.
» Set the parameters for each channel used.

» Click Accept.

» Carry out a voltage reset of the gateway.

NOTE
ﬂ The gateway reads out the parameters of the RFID electronic modules after a voltage
reset. Faulty parameters are also accepted by the gateway.

BLxx-2RFID-S - Bit assignment of the data bytes

Byte no Bit

7 6 5 4 3 2 1 0
0 reserved (bit 7 must be set to 1) Transmission level channel 1
1 reserved (bit 7 must be set to 1) Transmission level channel 2
2 Operating mode Transmission frequency ~ “0”

channel 1 channel 1
3 Operating mode Transmission frequency ~ “0”

channel 2 channel 2
4 Error code  Tag type channel 1
5 Bridging time channel 1
6 Error code  Tag type channel 2
7 Bridging time channel 2
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Parameters for HF application - Overview

Default values are shown in bold type.

Parameter name Values Description

Operating mode 0 = Standard access The read/write head detects the tag type viaa GET_SYSTEM_
INFORMATION command. The automatic detection of the
tag (see parameter Select tag type = automatic detection) is
possible.

1 = Fast access Access is faster than with standard access. A GET_SYSTEM_
INFORMATION command is not sent. The automatic tag detec-
tion is not possible (see Select tag type parameter).

Select Tag Type 0 = Automatic detection The tag is detected by means of its UID (only valid with Philips
I-CODE SLI SL2, Fujitsu MB89R118, Tl Tag-it HF | Plus and Infi-
neon SRF55V02P tag types).

1 = Philips I-CODE SLI SL2 Selection of the tag used; the tag type used must be selected
2 = Fujitsu MB89R118 in all cases with Fast access mode.
3 =Tl Tag-it HF | Plus

4 = Infineon SRF55V02P

5 = Philips I-CODE SLI S

6 = Fujitsu MB89R119

7 =Tl Tag-it HF-l

8 = Infineon SRF55V01P

9 =Turck TW-R50-K8

10 = Melexis MLX90129

11 =NXP |-CODE SLI L

12 = Fujitsu MB89R112

13 = EM4233SLIC

Bridging time 0 = Use default value of the Set the bridging time, depending on the application
read/write head, normally 200
ms

T=4ms

2=8ms

255=1020 ms

Data arrangement 0 =Byte 1-2/13-14 Defines the position of the error code in the data image.
1=Byte 2-3/14-15 With word—basgd fieldbus systems such as Modbus TCP,
choose the setting 1 = Byte 2-3/14-15
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Parameters for UHF applications — Overview

NOTE

With UHF only the functions of the RFID electronic modules can be set via the DTM.
The WebConfig software application enables the extensive parameterization and
configuration of the read/write heads. To connect with a PC we recommend the STW-
RS485-USB interface converter (Ident no. 7030354) together with the STW-RS485-
USB-PS power supply unit (Ident no. 7030355). This WebConfig software tool is only
designed for users who wish to make more extensive settings to the read/write heads
in addition to the parameter options via the DTM. Information on the WebConfig soft-
ware is provided in the user manual BL ident® Software WebConfig for UHF Read/write

heads” (D500010).

Default values are shown in bold type.

Parameter name

Operating mode

Values

0 = Standard access

1 = Fast access

Description

With UHF the parameter must be set to 0 = Standard access.

Transmission frequency = 0=Band 1 TN865... TNO917...
865.7 MHz, channel 4 917.3 MHz, channel 2
1=Band 2 TN865... TNI17...
866.3 MHz, channel 7 917.9 MHz, channel 5
2=Band 3 TN865... TN917...
866.9 MHz, channel 10 918.5 MHz, channel 8
3=Band 4 TN865... TN917...
867.5 MHz, channel 13 919.1 MHz, channel 11
Transmission level (ERP) TN...-Q120L130-V1147 TN-Q175L200-H1147
e 0=Level 1 6 dBm 9 dBm
If transmission level 8
is selected, the basic 1=Level2 9dBm 12dBm
settings for the antennas 2 = Level 3 12 dBm 15 dBm
and transmission output ~ 7 oy 15dBm 18 dBm
configuration are used
which are definedinthe 4 =Level 5 18 dBm 21dBm
WebConfig software 5=Level 6 21 dBm 24.dBm
application.
6 =Level 7 24 dBm 27 dBm
7 =Level 8 max. 27 dBm max. 30 dBm

Tag type selection

0 = Automatic detection

With BL ident® UHF the parameter must be set to 0 = auto-

matic detection.

Bridging time

adjustable between 0...255
(dec.)
Default: 0

With UHF heads, the parameter defines the number of re-
peated write and read operations.

Error code position

0 =Byte 1-2/13-14

1 = Byte 2-3/14-15

The parameter defines the position of the error code in the
data image. With word-based fieldbus systems such as Modbus
TCP, choose the setting 1 = Byte 2-3/14-15.
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832  HF applications — Setting the Mode parameter

» Choose between Standard access and Fast access from the drop-down menu.

833  HF applications — Selecting the Tag type parameter

» Choose between automatic detection or the used tag from the drop-down menu.

834  HF applications — Matching mode and tag type

The two parameters Mode and Tag type can be combined as follows:

Operating mode Tag type

Standard access Automatic detection
Standard access Tag

Fast access Tag

Combining Standard access and Automatic detection

» Select Standard access under Mode.

» Select Automatic detection under Tag type.

= The tag is automatically detected by the read/write head. The UID of the tag is read before
access.

Combining standard access with a specific tag

» Select Standard access under Mode.
» Select the tag used under Tag type.
= Tags that cannot be detected by the read/write head can be accessed.

Combining fast access with a specific tag

» Under Mode select Fast access.

» Select the tag used under Tag type.

= Access to tags is faster because the tag type and the UID do not have to be read out. The spe-
cific properties of the tag used are known before access, the required UID is also transmitted
with read/write operations.

NOTE
ﬂ Fast access mode does not support the Philips SL1 and Turck TW-R50-K8 tags.
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8.3.5

124

HF applications — Setting the Bridging time parameter

Due to the expansion of the HF transmission zone the tag may drop out momentarily during a
write or read operation and then later return again. The period between the drop out and the
return to the transmission zone must be bridged so that the write or read operation is complet-
ed. The bridging time is the time between the dropout and the return to the detection range.
The bridging time parameter takes up 1 byte in the parameter data image (0...255).

The bridging time parameter depends on the components used, the write/read distances, the
speed of the tag to the read/write head and other external factors.

The following figure shows the typical characteristics of the sensing range and the path cov-
ered by the read/write head. A shows the section to be bridged:

\\

N

\
/
;/—

Fig. 116: Detection range of a read/write head

Retaining the default setting

» Retaining default setting 0: If the commissioning is successful, the parameter does not have
to be adjusted to the application. If the commissioning is not successful, the error message
“Dwell time of the tag in the sensing range was insufficient to process the command success-
fully” (error code: DW#16#E1FE02xx).

» If the error message appears, check whether the recommended distances can be achieved by
reducing the speed or data volume. The information “Recommended distance” and “Maxi-
mum distance” is provided in the product-specific data sheet as well as in the RFID engi-
neering manual (D500024). If this is not possible, the bridging time must be adapted to the
application.

Adapting the bridging time to the application
» Measure the required bridging time directly on location. The LEDs of the read/write head and

the TP status bit of process input data indicate whether the tag is in the sensing range or not.
» Enter the required bridging time in the DTM.
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8.3.6  HF applications — Setting the Data arrangement parameter
The Data arrangement parameter defines the position of the error code in the data image.
» With word-based fieldbus systems such as Modbus TCP, choose the setting 1 = Byte
2-3/14-15.
8.3.7  UHF applications — Setting the Mode parameter

» Select Standard access from the drop-down menu. Standard access is not supported with
UHF applications.

8.3.8  UHF applications — Setting the UHF frequency band parameter

The UHF frequency band parameter can be set for the TN865-... and TN917-... UHF read/write

heads.
» Select the required frequency band from the drop-down menu.

839  UHF applications — Setting the UHF transmission level
The UHF transmission level parameter is used for selecting the transmission level 1 to 8 for the
UHF read/write heads. Selecting transmission level 8 accepts the basic settings from the Web-
Config parameter tool.

> Select the required transmission level from the drop-down menu.

The basic default settings of the read/write heads are as follows:

Parameters TN...-Q120L130-V1147 TN...-Q175L200-H1147
Transmission frequency Band 1 (865.7 MHz with TN865... and Band 1 (865.7 MHz with TN865... and

917.3 MHz withTN 917...) 917.3 MHz withTN 917...)
Transmission level ERP [dBm] - circular 27 30

8.3.10 UHF applications — Selecting the Tag type parameter

» Select Automatic detection from the drop-down menu.
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8.3.11 UHF applications — Setting the Bridging time parameter

The Bridging time parameter with UHF applications corresponds to the number of automatic
retries for a read or write operation before the read or write operation is reported as failed.

Example:
The bridging time parameter is 0. The tag is to be read but this is not possible due to a fault.
The read operation is not repeated and has therefore failed.
The bridging time parameter is 1. The tag is to be read but this is not possible due to a fault.
The read operation is repeated automatically once, the data could be read. The read opera-
tion is successful.

» Enter the number of automatic retries.

NOTE
ﬂ The setting of the Bridging time parameter to 20 has proved in practice to be useful for
UHF applications.

8.3.12 UHF applications — Setting the Data arrangement parameter
The Data arrangement parameter defines the position of the error code in the data image.

» With word-based fieldbus systems such as Modbus TCP, choose the setting 1 = Byte
2-3/14-15.
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84  Reading measured values with the DTM

The Measured values function enables the reading of all input values which the RFID electronic
modaule has detected.
» Establish the connection between host PC and BL ident® interface.
» Right-click the RFID electronic module.
» Choose the Measured values function.
= The connection between host PC and RFID interface is active. The DTM of the BLxx-2RFID-S

module indicates active communication with a green icon.

Project o ox
Device tag Addres [ 2 «|Device type (DTM) Status Timestamp status
HOST PC
B= TCP:192.168.1.50 # =1= = BL Service Ethernet O
=7 192.168.1.254/BL67-GW-EI # == =" BL67-GW-EN (>= VN 03-00) O
= Modulbus == & Modulbus
- == 01/BL67-2RFID-S 01 # == =" BL67-2RFID-S O
Fig. 117: Active connection between BL ident® interface and the host PC
[ = 01/BL67-2RFID-S # Measured value [ =@ [=]
s Device type BLE7-2RFID-S e
Descrigtion BL67 RFID system interface for connection of BL Ident write-read heads. —
.;- Au
OO @ e [T Measured value
Name Valus -

= RFID channel 0
Input values
DETUMED

TFR

TP
HCWE_ON
HCWR_COM
Errar

Busy

Done

Errar code
Fead data

= RFID channel 1

- Input values

*CWR_DETUMED
TFR
TP
HOWR_ON
=CWR_COM
Errar
Busy
Done
Erar code
Read data

[Cltransceiver range tuned

[Cltag not fully read

[Clno target present

[Ctransceiver turmed off

[“ltransceiver connected

no error, error code is not up to date

[Cllast command finished

[Vllast command finished, system waits for new command
0000

0000000000000000

[Cltransceiver range tuned

[Cltag not fully read

[Clno target present

[Ctransceiver tumed off

[Clno transceiver connected

no error, error code is not up to date

[Cllast command finished

[Yllast command finished, system waits for new command
0000

0000000000000000

% Connected

Ea i Device f

Fig. 118: Measured values window
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Process input data - RFID-S

Bit Value
XCVR_DETUMNED | 0
1

m

Meaning

tansceiver range
tuned

Various long-range
RFID transceivers
check the
transmitter tuning.

If the transceiver
detects a detuning
which will
decrease the
range of about
thirty per cent, a
“range restricted"”
error will be
generated.

Most of the
transceivers
indicate this by
switching on a
yellow LED.
Action: increase
the distance to i

P P TN

Close
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8.5  Testing functions — Simulation

The Simulation function enables the values of the output parameters of the RFID electronic
modaules to be set directly using the Force mode in order to test and simulate the operation of
the RFID system.

» Establish the connection between host PC and BL ident® interface.

» Right-click the RFID electronic module.

» Choose the Simulation function.

= 01/BL67-2RFID-S # Simulation o | & | =
i Device type BL67-2RFID-S rurc
i i Descriptian BL67 BFID system interface for connection of BL Ident write-read heads. 1
.-I Indusirial
BEO®® @ ;& = - Simulation
MName TEE - -
£ Output values Process output data - RFID-S

Reset [Cno reset

*WE Infa [[Jeommand off Bit Value | Meaning L

TG Info [Clecommand off Reset 0-=1 A "Reset” of the BLident @-system i

Wit [Cleommand off is completed with the increasing

Faoad [Clcommand off edge. When the status bit "BUSY”

TAGID Cleommand off is set, the execution of the active

0 ) ; command is interrupted and the

MNext next mode rnacal‘rve status bit "DONE" is set.

XCWR [Cturr off transceiver The status bit "ERROR" and the

Get [Cleommand off two byte error message (error

Biyte count read /write 1 byte code) of the process input data are

Diarmain 0 deleted.

Address 0000 XCVR 0-=1 | TRANSCEIVER_INFO (information

\Wiite data 0000000000000000 Infa for readfwrite head) is initiated and

executed with the increasing edge.

= RFID channel 1 Together with the process input

1

= Output values data the information is sent to the
Feset [Cno reset read/fwrite head in the read data
#CWR Info [Cleommand off range with 8 byte:

The content of the information can

TA.G Infc Dloommand off be configured. The content of the
irite Cleommand off information is selected with
Read [Cleommand off "AddrHi. Addrlo".
TAGID [Clcommand off 0=x00F0:
et [Jnext mode inactive The first & byte of the ORDER_ID
P here: product description) are
- 0x54 4E 45 52 2D 51 38 30(ASCII-
Byte count read /write 1 byte table)
Damain 0 0:00F1:
Address 0000 The second 8 byte of the
Write data 0000000000000000 ORDER_ID (here: product
- description) are sent, for example: -
% Connected Ea i Dewvice f

Fig. 119: Simulating operation
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Testing functions — Simulation

» Start Force mode by double-clicking an output value or via the Force Mode button (high-
lighted in red).
» Confirm the subsequent prompt with OK.

-

<192.168.1.254/BL67-GW-EN (>= VN 03-00)> Turck BL67-GW-EN (>= VN .. | 23 |

Force Mode will be activated for write access to this device.
¥’ (Cancel: The Force Mode will not be activated)

Note:

With the activation of the Direct Mode, the station is
disconnected from the field bus and no longer controlled by the
PLC.

All outputs will be reset shortly, then they will be set to the
previously valid values.

OK I l Abbrechen

Fig. 120: Prompt: Activating Force mode

= Force mode is started and the values can be written directly to the BLxx-2RFID-S module. In
Force mode the BL ident® interface is automatically disconnected from the PLC controlled by

the host PC.
» Change the required output values.
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86  Performing diagnostics with the DTM

The Diagnose DTM function enables the display of diagnostic messages for the entire RFID
system as well as the individual RFID electronic modules.

Examples of global error messages for the RFID system:
Faulty communication via the module bus
Insufficient power supply

Examples of special error messages on the RFID electronic modules:
Overcurrent
Obsolete firmware
Insufficient power supply

» Establish the connection between host PC and BL ident® interface.

» Right-click the RFID electronic module.

» Choose the Diagnose function.

= The connection between host PC and RFID interface is active. The DTM of the BLxx-2RFID-S
module indicates active communication with a green icon.

Project =
Device tag Addres 0 |5 «|Device type (DTM) Status Timestamp status
HOST PC
== TCP:192.168.1.50 # =I= =" BL Service Ethernet 9]
=" 192.168.1.254/BL67-GW-EI # == =" BL67-GW-EN (>= VN 03-00) o
“E% Modulbus == ¥ Modulbus
- == 01/BL67-2RFID-S 01 # == =" BL67-2RFID-S O

Fig. 121: Active connection between BL ident® interface and the host PC

= 01/BL67-2RFID-S # Diagnosis o | =3 | =
o Device type BL67-2RFID-S TUrRCE
Description BL67 RFID system interface for connection of BL Ident write-read heads. 1
I Industril
L
B~ @@ = - Diagnostics
Name Yalue -
= RFID channel 0 Diagnostic messages
- Diagnostics
rert Diagnostic Meaning
Transceiver parameter not su... message
hodule parameter invalid Overcurrent | Overcurrent /short circuit power line at the

Hardware failure transceiver
Transceiver indicates power s...
Errar
Error code
=l RFID channel 1

- Diagnostics
Cwercurrent
Transceiver parameter not su...
Module parameter invalid
Hardware failure transceiver
Transcerer indicates power s...
Error
Errar code

no error, error code is not up fo date
0000

no error, error code is not up to date
0000

ﬂ? Connected

E@ g Device f

Fig. 122: Diagnosis window
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1st and/or the 2nd channel. If the L
diagnosis is not assigned to a particular
channel, the diagnosis of the 2nd channel

is mapped to the 1 st channel. (**)

Transceiver |The selected parameter settings are not

parameter  |valid for the connected read-write-head.
not Please observe: the operation mode "fast
supported access” is not allowed for UHF.
The firmware of the read-write-head may
be out-dated and an update may be
necessary.
Module The parameterization of the module is
parameter  |invalid, the selected parameter settings
invalid do not match.
Please observe the description of the
module parameters.
Hardware The module detected a hardware-error at

Close
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9 Operation

9.1 LED indication functions

LED indication functions

9.1.1  BL20 gateways
Standard gateways
LED Status Meaning Remedy
10s OFF No gateway power supply. Check the system power supply present on
the gateway.
green The configured components match the
module bus stations present; Communica-
tion active.
green flashing, 1 Hz  Force mode active in the DTM Deactivate the Force mode in the DTM.
green flashing,4Hz  Too many modules connected to the Remove surplus modules.
gateway.
red Gateway not ready —Check the system power supply present
Possible causes: on the gateway and the connections.
—Power supply V¢ too low —Remove surplus modules.
-too many modules on gateway - Replace the gateway.
—short-circuit in connected module
- Gateway faulty
red flashing, 1 Hz The configured components do not match —Compare the configured components
the module bus stations present. The gate- with the module bus stations present.
way is not detecting the electronic modules ~ ~ Check the setup of the interface for faulty
. or incorrectly fitted electronic modules.
automatically.
red flashing, 4 Hz No communication via the module bus Fit at least one electronic module.
red/green flashing,  The configured components do not match Check the interface for new unconfigured
1Hz the module bus stations present. The modules.
gateway detects the electronic modules
automatically, the data exchange is active.
GW OFF No gateway power supply. Check the system power supply present on
the gateway.
green Gateway operational
green flashing, 1 Hz ~ Firmware not up-to-date or faulty —Reload the firmware.
and LED 10s: red - Contact your TURCK customer advisor.
green flashing, 4 Hz  Hardware error, firmware active Replace the gateway.
red Hardware error, firmware faulty —Check the system power supply present
Gateway not ready on the gateway and the connections.
Possible causes: —Remove surplus modules if necessary.
—Power supply Vcc too low -Replace the gateway.
-too many modules on gateway
—short-circuit in connected module
- Gateway faulty
LINK/ACT OFF No Ethernet Link Check the Ethernet connection.
green Ethernet link established, 100 Mbit/s

green flashing

Ethernet traffic 100 Mbit/s

yellow

Ethernet link established, 10 Mbit/s

yellow flashing

Ethernet traffic 10 Mbit/s

2015/11
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LED Status Meaning Remedy
MS green Logical connection to a master established
green flashing Gateway operational
red Gateway indicates error: Check the IP addresses in the network.
IP address conflict
Gateway in RESTORE mode
F_Reset activated
red/green flashing ~ Auto-negotiation and/or Waiting for auto-negotiation and/or
DHCP/BootP search of the settings addressing.
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BL20-ECO gateways

LED indication functions

NOTE
The BL20-ECO gateways have different LEDs for displaying fieldbus communication,

depending on the hardware version. With gateways before hardware version VN03-00
the fieldbus communication is indicated via the MS LED, with gateways from version
VN 03-00 via 2 LEDs BUS and ERR.

LED Status Meaning Remedy
10s OFF No gateway power supply. Check the system power supply present on
the gateway.
green The configured components match the
module bus stations present; Communica-
tion active.
green flashing, 1 Hz  Force mode active in the DTM Deactivate the Force mode in the DTM.
green flashing, 4 Hz  Too many modules connected to the Remove surplus modules.
gateway.
red Gateway not ready —Check the system power supply present
Possible causes: on the gateway and the connections.
—Power supply Vcc too low —-Remove surplus modules.
~too many modules on gateway - Replace the gateway.
- short-circuit in connected module
—Gateway faulty
red flashing, 1 Hz The configured components do not match -Compare the configured components
the module bus stations present. The gate- with the module bus stations present.
way does not adapt the electronic modules ~ ~ check the setup of the interface set for
) faulty or incorrectly fitted electronic
automatically. modules.
red flashing, 4 Hz No communication via the module bus Fit at least one electronic module.
red/green flashing,  The configured components do not match Check the interface set for new unconfig-
1 Hz the module bus stations present. The gate-  ured modules.
way adapts the electronic modules auto-
matically, the data exchange is active.
GW OFF No gateway power supply. Check the system power supply present on
the gateway.
green Gateway operational
green flashing, 1 Hz ~ Firmware not up-to-date or faulty —Reload the firmware.
and LED 10s: red —Contact your TURCK customer advisor.
green flashing, 4 Hz  Hardware error, firmware active Replace the gateway.
red Hardware error, firmware faulty - Check the system power supply present
Gateway not ready on the gateway and the connections.
Possible causes: —Remove surplus modules if necessary.
—Power supply V¢ too low ~Replace the gateway.
-too many modules on gateway
—short-circuit in connected module
- Gateway faulty
LINK/ACT OFF No Ethernet Link Check the Ethernet connection.
green Ethernet link established, 100 Mbit/s

2015/11

green flashing

Ethernet traffic 100 Mbit/s

yellow

Ethernet link established, 10 Mbit/s

yellow flashing

Ethernet traffic 10 Mbit/s
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LED Status Meaning Remedy
BUS green Logical connection to a master established
green flashing Gateway operational
red Gateway indicates error: Check the IP addresses in the network.

- 1P address conflict
—Gateway in RESTORE mode
—F_Reset activated

red/green flashing ~ Auto-negotiation and/or Waiting for auto-negotiation and/or
DHCP/BootP search of the settings addressing.
ERR OFF No fault present.
red Diagnostic message of the gateway or an Check the diagnostic messages.

electronic module present
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LED indication functions

9.1.2  BL67 gateways
LED Status Meaning Remedy
10s OFF No gateway power supply. Check the system power supply present on
the gateway.
green The configured components match the
module bus stations present; Communica-
tion active.
green flashing, 1 Hz  Force mode active in the DTM Deactivate the Force mode in the DTM.
red Gateway not ready Check the system power supply present on
Possible causes: the gateway and the connections.
—tcr’]o Ta!"y nwtqdules on tgaéewa()j/ | Remove surplus modules.
- short-circuit in connected module
_Gateway faulty Replace the gateway.
red flashing, 1 Hz The configured components do not match —Compare the configured components
the module bus stations present. The gate- with the module bus stations present.
way does not adapt the electronic modules ~ ~ check the setup of the interface set for
. faulty or incorrectly fitted electronic
automatically. modules.
red flashing, 4 Hz No communication via the module bus Fit at least one electronic module.
red/green flashing,  The configured components do not match Check the interface set for new unconfig-
1Hz the module bus stations present. The gate-  ured modules.
way adapts the different modules, the data Check the system power supply present.
exchange is active.
SET button actuated with Vo missing.
GW OFF No gateway power supply. Check the system power supply present on
the gateway.
green Gateway operational
green flashing, 1 Hz  Force mode active in the DTM Deactivate the Force mode in the DTM.
green flashing, 1 Hz ~ Firmware not up-to-date or faulty —Reload the firmware.
and LED 10s: red - Contact your TURCK customer advisor.
green flashing, 4 Hz  Hardware error, firmware active Replace the gateway.
red Hardware error, firmware faulty —Check the system power supply present
Gateway not ready on the gateway and the connections.
Possible causes: - Eemlovets#rpluts modules if necessary.
—Power supply V¢ too low ~heplace the gateway.
—too many modules on gateway
—short-circuit in connected module
- Gateway faulty
red flashing, 1 Hz Wink command received
ERR OFF System running fault-free
red Diagnostic message of the gateway or an Check the diagnostic messages.
electronic module present
VCC green Power supply Vc fault-free
OFF Gateway not supplied Check the power supplies present on the

VCC <18V orVcc > 30V (possibly short
circuit)

gateway.
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LED Status Meaning Remedy
Vo green Output power supply V, fault-free
green flashing, 1Hz  Undervoltage V,, system running Check the power supplies present on the
green flashing,4Hz  Overvoltage V, system running gateway.
OFF Output power supply Vo missing
Vv, green Input power supply V, fault-free
red Short-circuit or overload on Rectify the short circuit or overload.
sensor power supply Vens Sensor supply The gateway restarts automatically as soon
disconnected as the error is no longer present.
green flashing, 1 Hz  Undervoltage V, system running Check the power supplies present.
green flashing, 4Hz  Overvoltage V), system running
OFF Input power supply V| missing
LINK/ACT OFF No Ethernet Link Check the Ethernet connection.
green Ethernet link established, 100 Mbit/s
green flashing Ethernet traffic 100 Mbit/s
yellow Ethernet link established, 10 Mbit/s
yellow flashing Ethernet traffic 10 Mbit/s
BUS green Logical connection to a master established
green flashing Gateway operational
red Gateway indicates error: Check the IP addresses in the network.
—IP address conflict
—Gateway in RESTORE mode
—F_Reset activated
red/green flashing Auto-negotiation and/or Waiting for auto-negotiation and/or
DHCP/BootP search of the settings addressing.
9.1.3  RFID electronic modules
LED Status Meaning Remedy
DIA OFF Normal data exchange
red Module bus communication has failed Check whether more than two adjacent
electronic modules have been removed.
Modules located between the gateway and
the module concerned are relevant.
red flashing, 0.5 Hz  Diagnostics present
RWO OFF No tag in receive range
RWI green Tag in receive range
green flashing, 2 Hz Data transmission from/to the tag
red Channel error, details in the diagnostic
message
red flashing, 2 Hz Short-circuit of read/write head power
supply
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9.14  BL compactinterfaces
Station LEDs
LED Status Meaning Remedy
10s OFF Interface not supplied with power. Check the system power supply present at the
interface.
green Communication active
green flashing Force mode active in the DTM Deactivate the Force mode in the DTM.
red Interface not operational, no power sup-  Check the system power supply present at the
ply present interface and the connections.
red flashing, 1 Hz The configured components do not Compare the configured components with
match the components present. the components present.
red flashing, 4 Hz No communication via the module bus
BUS OFF No fieldbus communication active
green Fieldbus communication active
green flashing No fieldbus communication active, de-
vice operational
red Bus error, no data exchange Check the bus connection
red flashing Wink command received
yellow DHCP/BootP search of the settings
LINK/ACT  OFF No Ethernet Link Check the Ethernet connection.
green Ethernet link established
green flashing Data transmission via Ethernet active
yellow Ethernet link established, 100 Mbit/s
1/0 LEDs
LED Status Meaning Remedy
DIA OFF Normal data exchange
red Module bus communication has failed Check whether more than two adjacent
electronic modules have been removed.
Modules located between the gateway and
the module concerned are relevant.
red flashing, 0.5 Hz  Diagnostics present
RWO OFF No tag in receive range
RW1 green Tag in receive range

green flashing, 2 Hz

Data transmission from/to the tag

red

Channel error, details in the diagnostic
message

red flashing, 2 Hz

Short-circuit of read/write head power
supply

2015/11
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9.15 HF read/write heads

LED 1

Depending on the device type, the HF read/write heads are provided with different LEDs, e.g. to

indicate the operating voltage and the operating state.

LED 2

Function

continuously
lit
flashing (1 Hz)

Operating voltage switched on

HF field switched off

flashing (2 Hz)

Tag within the detection range

lit yellow (with read/write
heads with automatic

tuning)

less than 50 % range, too much metal in the environment

9.16  UHF read/write heads

LED 1 (green) LED 2 (yellow) LED 3 (red) Function

off off off Operating voltage switched off

white white white Startup

continuously off off Operating voltage switched on, radio field switched off, no
lit internal error

continuously continuously off Operating voltage switched on, radio field switched on, no

lit

lit

internal error

continuously
lit

continuously
lit

continuously
lit

Operating voltage switched on, radio field switched on,
internal error

flashing

off

off

Access to the tag successful

flashing

continuously
lit

off

Tag located in the radio field

Running light: green > yellow > red

Test mode
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Diagnostic messages — RFID electronic modules

9.2  Diagnostic messages — RFID electronic modules

The error and warning code of an RFID electronic module is transferred with two bytes of the
process input data.

Byte no. Bit
7 6 5 4 3 2 1 0
0 DONE BUSY ERROR XCVR_CON XCVR_.ON TP - res.
1 Error code (2 bytes) LSB
2 MSB
3 res. res. res. res. res. res. res. res.
4 8 bytes read data (READ_DATA)
5
6
7
8
9
10
11
In the table below, the first place of the error code in bold type is represented by the 2nd byte
of the process input data, the two last places in bold type by the 3rd byte.
Example: DW#16#E1[2nd byte process input data]FE01[3rd byte process input data]xx
The following table shows the meaning of the error codes:
Error code Meaning
DW#16#E1FE01xx Tag memory error (e.g. CRC error).
DW#16#E1FE02xx Dwell time of the tag in the sensing range was insufficient to process the command successfully.
DW#16#E1FE03xx The stated address range or command does not fit the tag type used.
DW#16#E1FE04xx  Tagis faulty and must be replaced.
DW#16#E1FE08xx Tag in the detection range does not have the expected UID/UII.
DW#16#E1FE09xx  Tag does not support the current command.
DW#16#E1FEOAXx At least one part of the stated area in the tag is write protected.
DW#16#E1FE80xx  Tag reporting a non-specified error (undefined/general error per ISO 15693).
DW#16#E1FEFFxx Tag reporting an unknown error (error code not defined in ISO 15693).
DW#16#E2FE01xx Communication time between tag and read/write head exceeded.
DW#16#E2FE02xx  Too many tags in the detection range.
DW#16#E2FE80xx CRC error at the air interface. The radio connection between the tag and the read/write head is dis-
turbed (e.g. due to EMC problem:s).
DW#16#E2FEFFxx Read/write head reports unknown error.
DW#16#E4FE01xx Supply of the read/write head switched off due to increased current consumption (e.g. short-circuit).
DW#16#E4FE03xx Antenna or transmitter of the read/write head is switched off.
DW#16#E4FE04xx Overflow of the command memory buffer — more than one command flag set within the process data.
DW#16#E4FE06xx A parameter of the current command is not supported.
DW#16#E4FE07xx Unspecified error was reported by the cyclical status word (e.g. antenna out of operation). The error is

independent of the actual command.

2015/11
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Error code Meaning

DW#16#E4FE80xx No read/write head connected.

DW#16#E4FE81xx  The read/write head is faulty.

DW#16#E4FE82xx Command to read/write head is faulty.

DW#16#E4FE84xx Telegram content invalid (with HF tags of type TW-R22-HT-B64). Range write-protected or not present.

DW#16#E4FE88xx Insufficient power supply of the read/write head.

DW#16#E4FE89xx The read/write head reports a permanent CRC error on the RS485 cable. Check the cable for EMC
problems.

DW#16#E4FE8Axx  The RFID electronic module reports permanent CRC errors on the RS485 cable. Check the cable for EMC
problems.

DW#16#E4FE90xx A command transferred via Get is not known by the read/write head.

DW#16#E4FEFDxx  Parameter setting impermissible.

DW#16#E4FEFEXx The selected parameter settings do not match the connected read/write head. The firmware of the read/
write head may be out of date and an update may be required.
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Diagnostic messages — RFID electronic modules

9.2.1  Diagnostics via the DTM

Diagnostic byte and bit DTM name

Diagnostic channel 1

0 0 reserved
1 reserved
2 Ident overcurrent: The power supply of the read/write head is switched off.
5 Software update for read/write head required
6 Invalid parameter

1 0 Transceiver hardware error
1...2 reserved
3 Transceiver power supply error
4..7 reserved

Diagnostic channel 2

2 0 reserved
1 reserved
2 Ident overcurrent: The power supply of the read/write head is switched off
5 Software update for read/write head required
6 Invalid parameter

3 0 Transceiver hardware error
1...2 reserved
3 Transceiver power supply error
4.7 reserved

2015/11
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10 Troubleshooting

Faults of the BL ident® system are reported by the system components. The meaning of the
diagnostic messages is provided in the chapter Operation.

Information on EMC interference and possible remedies are provided in the RFID Systems Engi-
neering User Manual (D500024).
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11 Maintenance

11.1  Updating the firmware

NOTE
ﬂ The user can only update the firmware of the gateways. Contact Turck Service for a
firmware update of the read/write heads or the RFID electronic modules.

The current firmware is provided as a ZIP file on the Internet at www.turck.de. To update the
firmware you need the FDT PACTware™ and the DTM of the gateway used.

I:?
<
DANAT

| ™
AUV TANDY

» Download the firmware from www.turck.de.

» Unpack the ZIP file on your PC.

» Connect the gateway to a host PC via the Ethernet interface.
» Launch PACTware™.

» Right-click Host PC.

» Choose Add Device.

File Edit View Project Device Extras Window Help
NSdHS B [BE 0w 8 85 E

Connect
Disconnect

Topology Scan

Add device

Fig. 123: PACTware™ - Adding a device

> Add BL Service Ethernet to the project tree.

Al Devices
Device ~|Protocol | Vendor  Group | Device Versior FDT version | DTM version
BL Service Erhernet BL Service Ethd Turck DTM sped 100 07-06f 1.2.0 Aclclemndy 1.00.2 7 15-08-0

= Bl Senvice RS232 Bl Senvice  Turck DTM specific 100/ 3007-0¢ 1.20 Addendy 1.00.2107 / 2015-08-06
< HART Communication  HART CodeWrights GmbH o7 10:52 f 2015-C L20 Addendu 1052 / 2015-03-17
7 I0-Link USE Master 20 10Uk 10-Link o1 2000002/ 20:1.21 2000002} 20130819
E’ﬁs«m«mmummu

=n

Fig. 124: Adding BL Service Ethernet to the project tree
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» Right-click the device to be added.
» Open the Bus Address Management.

File Edit View Project Device Extras Window Help
DEFdHd| =R R

| Device tag

Connect

Disconnect

Load from device
Store to device

Parameter
Measured value
Simulation

Diagnosis

Display channels
Channels »

Topology Scan
Diagnostic Scan
Up-/Download-Manager

Seri.. Date Source
|

1]

PACTware

supported by

Print »
Additional functions 4 Compare offline
Add device Compare online
Exchange device Set value
Delete device Scan list
Properties <TCP:192.168.1.50>BL Service Ethernat Identification
About / Update DTM
Busaddress management
Browser
HIMA Export
Accessory

Preset DTM TAG (address/tag)
DTM maintenance

Hans Turck GmbH & Co

Write device data to file

lax %[0 <nomamE>

" Administrator ‘

Fig. 125: Opening Bus Address Management
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» Click the following icon (marked in red) to search for connected gateways

rnet

ethernet communication DTM

w [l | 8| & & Busaddress management

Online awvailable devices | Add devices manuallyl

EAN—Verbindun 3 (192.168.1.50/255.255.255.0)

Device type Online ID | IP address Metmask

el il

Flanned devices I

Device type Online D |Busaddress Designation ('Tag")

Dewvice shoi

= Disconnected

Fig. 126: Search function in the Bus address management
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» Select the required gateway.
» Click the Info icon (highlighted in red) to display information on the latest firmware version.

1

ernet communication DTMW

B~ # 2 = | ipt | 0 M| & B Busaddress management I
Online available devices I EeEeices manuallyl
[LanN-verbindung 3 (192.168.1 50/255.255.255.0) |

« n 1 »

Flanned devices |

Online IO | Busaddress Designation ('Tag") Device short name

Device type

= Disconnected ’_| |7_,_,_,_| |

Fig. 127: Info icon

» Click the Firmware Download icon to update the firmware.
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et

ethernet communication DTM

B~ @ S & % | ) ipt | 2 Busaddress management
Online available devices I Add devices manually'

EAN-Verbindung 3({192.168.1.50/255.255 2565.0) - |

Device type Cnline I |IP address MNetmask

4

Planned devices I

Device type Cnline 1D |Busaddress Designation (Tag")

= Disconnected ’_|

Fig. 128: Firmware Download icon

» Select the unpacked firmware file.
» Click Open.
= The current firmware is loaded in the gateway.
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Maintenance

11.2  Replacing electronic modules

» Disconnect the BL ident® interface from the power supply.
» Detach the electronic module to be replaced from the base module.

NOTE

ﬂ The BL ident® electronic modules are protected from incorrect mounting by a two-sec-
tion coding element. The electronic module is supplied with the coding element fitted
on the bottom. After the initial mounting, the bottom section of the coding element
remains automatically in the corresponding recess of the base module.

Fig. 129: Replacing electronic modules — Coding element (right: BL20 interfaces, left: BL67 interfaces)

» Remove the bottom section of the coding element from the electronic module.

» Mount the electronic module.

» Connect the interface to the power supply.

» Press the SET button (BL67 gateways) or actuate the CFG-DIP switch (BL20 gateways) to ac-
cept the actual configuration to the memory of the gateway.
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12.1

13

14
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Returning devices

Repair

The system must not be repaired by the user. If a device is faulty, decommission it and send it to
Turck. Observe here the specific warranty conditions agreed with the shipment.

Returning devices

If a device has to be returned, bear in mind that only devices with a decontamination declara-
tion will be accepted. This is available for download at
http://www.turck.de/static/media/downloads/01_Declaration_of decontamination_EN.pdf
and must be completely filled in, and affixed securely and weather-proof to the outside of the
packaging.

Decommissioning

» Disconnect the interface from the power supply.
» Undo the connections between the system components.

Disposal
The devices are designed for installation in large-scale industrial installations and equipment.

The devices must be disposed of correctly and must not be included in normal household
garbage.
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Appendix: BLxx-2RFID-S module — Flow charts

15 Appendix: BLxx-2RFID-S module — Flow charts
15.1  Flow charts for the operation of the BLxx-2RFID-S module

The following flow charts provide an overview of the different commands and states of the
BLxx-2RFID-S RFID electronic module.

NOTE
ﬂ The scanning of the parameters DONE, ERROR, TP etc. must always be based on a
signal change (edge signal).

15.1.1 Basic state

Start
PLC-program active

Ready?
(DONE = true)
(ERROR = false

Error?

Read/write head
connected?
(XCVR_CON = true

no

Ground state by
statusbits:

DONE = true
XCVR_CON = true
BUSY =false

Fig. 130: Basic state flow chart
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15.1.2 Fault state

2015/11

Error?
(ERROR = true)

Error message
ERROR CODE = xx
ERROR CODE 1 = xx

+RESET”
required?

RESET command
(RESET = true)
[false = true — false]

LError” clear?
(ERROR = false)

Ready?
(DONE = true)
(RESET = false)

Basic status

Fig. 131: Fault state flow chart

Error?

Error?
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Appendix: BLxx-2RFID-S module — Flow charts

15.1.3  Switching the read/write head on and off

Ready?
(XCVR_CON = true)
(DONE = true)

no
Error?

(e.g. read/write head not
connected or unknown type)

Switch-on
read/write head?

/

XCVR command XCVR command
(XCVR =false) (XCVR = true)

Read/write head on?
(XCVR_ON = true)

Read/write head off?

2
(XCVR_ON = false) Error?

Basic status Ready for RFID-
communication:
DONE = true
BUSY = false
XCVR_CON = true
XCVR_ON = true
XCVR = true

Fig. 132: Flow chart for switching the read/write head on and off
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1514 Read command

2015/11

Error?

Flow charts for the operation of the BLxx-2RFID-S module

Ready for RFID-
communication

Ready?

(XCVR_ON = true)
(DONE = true)

ERROR = true

Preallocate values:
Byte Count=0...7
Address = 0...XXX
(UHF only:
Domain=0...3)

l yes

READ command
»| (READ =true)

[false = true — false]

,READ" active?
(DONE = false)
(BUSY = true)

Tag present?
(TP = true)

,READ"
successful?
(ERROR = false)
(DONE = true)

(BUSY = false)

Fig. 133: Read flow chart

Error?

« Command recessed:
READ =false

- Data available in
receive buffer:
READ DATA (8 Byte)

+ Ready for RFID-
communication:
DONE = true
BUSY = false
XCVR_CON = true
XCVR_ON = true
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Appendix: BLxx-2RFID-S module — Flow charts

15.1.5  Write command

Bereit flr
RFID-Kommunikation

Bereit?
(XCVR_ON = true)
(DONE = true)

nein ERROR = true

Fehler?

Werte vorbelegen:
Byte Count=0...7
Adresse =0...XXX
WRITE DATA (8 Byte)
(nur UHF:

Domain =0...3)

'
Kommando WRITE

(WRITE = true)
[false = true — false]

LWRITE" aktiv?
(DONE = false)
(BUSY = true)

nein

Datentrager
vorhanden?
(TP = true)

« Kommando ist
zurlickgesetzt:
WRITE = false

- Bereit fur RFID-
Kommunikation:
DONE = true
BUSY = false
XCVR_CON = true
XCVR_ON = true

JWRITE”
erfolgreich?

(ERROR = false)
(DONE = true)

Fehler?

Fig. 134: Write flow chart
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Flow charts for the operation of the BLxx-2RFID-S module

15.1.6  Tag-ID command

Ready for
RFID-communication

Ready?
(XCVR_ON = true)
(DONE = true)

TAG-ID command
(TAG-ID = true)
[false = true — false]

l

TAG-ID" active?
(DONE = false)
(BUSY = true)

Tag present?
(TP =true)

ERROR = true

Error?

JTAG-ID”
successful?

(ERROR = false)
(DONE = true)

Error?

- Command recessed:

TAG-ID = false

- Data available in

receive buffer:
READ DATA (8 Byte)

« Ready for RFID-

communication:
DONE = true
BUSY =false
XCVR_CON = true
XCVR_ON = true

Fig. 135: Tag-ID flow chart
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16 Glossary

156

AIDA

AIDA (Automation Initiative of German Automobile Manufacturers) is the name of the asso-
ciation of leading automobile manufacturers, which aims to establish a uniform standard for
production processes in the sector.

Air interface

The air interface is the RFID transmission zone resulting from the combination of tag and read/
write head. The air interface makes it possible to exchange information and supply the tags
with power (only with passive tags).

Antenna, active

An antenna normally consists of a coil which is used as a transmitting and receiving unit. The ra-
dio signals are transmitted between the read/write head and the tag via the antenna. An active
antenna is integrated in the electronics of the read/write head.

Anti-collision procedures

Anti-collision procedures are processes for the detection of multiple tags in the air interface of
a read/write head. To avoid a possible collision when receiving data, the tags are not addressed
exactly at the same time but in very rapid succession or via different frequencies within the
frequency band.

Operating frequency

The operating frequency describes the frequency band which is used to exchange information
between the tag and the read/write head. The frequency bands of the RFID applications are
precisely specified for every technology and there are national restrictions on the operating
frequency used.

BL compact

BL compact is the name of a compact I/O system from TURCK with IP67 protection. BL stands
for Bus Link.

BL ident

BL ident® stands for “Bus Link Identification” and is the name of the modular RFID system from
Turck.

BL20

BL 20 is the name of a compact I/O system from TURCK with IP20 protection. BL stands for Bus
Link.

BL67

BL 67 is the name of a modular I/0 system from TURCK with IP67 protection. BL stands here for
Bus Link.

Hans Turck GmbH & Co. KG | T +49 208 4952-0 | F +49 208 4952-264 | more@turck.com | www.turck.com



2015/11

Flow charts for the operation of the BLxx-2RFID-S module

Bus
A bus is a group of signal conductors for the transfer of data and control information between

different components (e.g. CPU, memory, I/0 level) according to a defined protocol. A bus can
be composed of a number of parallel cables for data transfer, addressing, control and power

supply.
CODESYS

CODESYS (Controller Development System) is a development environment and programming
system in accordance with IEC 61131-3 for PLCS and programmable automation components.

CPU

A CPU (central processing unit) is the processor of a computer which is the central element for
handling all important computing processes.

Data retention

Data retention denotes the lifespan of the data on a tag in years, depending on the ambient
temperature and other environmental factors.

Tag

A tag is a mobile data memory consisting of a memory chip and an antenna which can be
written or read in an RFID system without contact. The tag receives the incoming signals and
responds to the signals “independently”.

Tag, active

Active tags have their own internal energy source; the energy is used for the active transmission
of information and to supply the internal memory.

Tag, passive

Passive tags have no independent power supply and take their power for transmitting informa-
tion and for writing in the internal memory from the alternating electromagnetic field, which is
generated by the read/write head. This type of tag is mainly used in the Turck BL ident® system.
Class 1 DP master

A class 1 DP master (DPM1) is a central controller of a PROFIBUS-DP system, which exchanges
information with the remote slaves cyclically in a fixed telegram cycle. The DPV1 functions (acy-

clical transmission of user data) can be used as an additional option. Typical devices are PLCS or
PCs.
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Class 2 DP master

Class 2 DP masters (DPM2) are used exclusively to transmit acyclical user datain a
PROFIBUS-DP system and are used for tasks such as commissioning, maintenance and diag-
nostics in order to configure connected components. Typical devices include engineering or
operating devices. A class 2 DP master does not have to be permanently connected to the bus
system.

DPV1

DPV1 is an enhanced functionality of PROFIBUS-DP which allows the acyclical transfer of user
data with acyclical communication functions in addition to the cyclical process data. The acycli-
cal services are conducted at the same time and in addition to the cyclical process data trans-
mission with lower priority.

DTM

DTM stands for Device Type Manager and denotes the application independent driver for
computer-programmed devices and communication devices within an FDT defined frame ap-
plication (such as PACTware™). The DTM includes:

User interface for the device

Device logic and parameterization

EAN

The EAN (European Article Number) is the previous designation (discontinued since 2009) for
the internationally standardized global trade item number, GTIN.

EEPROM

An EEPROM (electrically erasable programmable read only memory) is a non-volatile electronic
memory module, which is provided to ensure that data stored on it can only be read and not
electronically deleted and reprogrammed.

EIRP - effective isotropic radiated power

EIRP denotes the radiated power including antenna gain. The EIRP value of antenna gain is
based on an isotropic radiator.

Electronic module

The electronic modules provide the different functions of the Turck modular I/0 systems in a
fieldbus station, and are independent of the particular fieldbus used. The electronic modules
are fitted to the base modules and form with them a functional unit. The electronic module
remains independent of the wiring and can thus be replaced at any time with an electronic
modaule of the same product series with the same functions. Possible functions:

Digital inputs and outputs

Analog inputs and outputs

Technology modules such as RFID

Power supply
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EMC

By EMC (electromagnetic compatibility) is meant the ability of an electrical device to operate
satisfactorily in an electromagnetic environment without adversely affecting or being adversely
affected by other electrical equipment.

EPC

The electronic product code (EPC) is an internationally used key and coding system for the
unique identification of products, packaging and product types through the individual alloca-
tion of serial numbers.

ERP - effective radiated power

ERP denotes the radiated power including antenna gain. The ERP value of antenna gain is
based on a half-wave dipole.

FDT

FDT stands for Field Device Tool and describes the interface definition between the specific
device DTMS used and the frame application (such as PACTware™). The FDT includes:
Standard user environment for all DTMS
User management
Management of the used DTMS
Network configuration

Fieldbus

A fieldbus connects the stations in the field (such as sensors and actuators) in order to com-
municate with the process components (such as PLC, SCADA, industrial PC). A fieldbus typically
offers a high transmission security and a real-time behavior. Fieldbus systems can be exposed
to severe external conditions and are primarily used in industry.

FRAM

An FRAM or Ferro RAM (ferroelectric random access memory) is a non-volatile electronic
memory module based on crystals with ferroelectric properties, which can be read or written.
The key features of the FRAM memories are the low power consumption, short write times and
a high degree of data reliability.

Function block

A function block is a self-contained program which provides different status, input and output
bits as well as routines. Several designated instances of a function block can be created.
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Gateway

By gateway is meant the hardware and software which connects different networks with dif-
ferent protocols (protocol converters). For this all the information of a telegram apart from the
user data is converted from the source protocol to the destination protocol. In the modular
Turck I/0 systems, the gateway is the head of the particular fieldbus station and forms the inter-
face between the fieldbus and the field level.

Gateway, programmable

The gateways which can be programmed with CODESYS according to IEC 61131-3 can be used
as a PLC to independently control applications or act as a subordinate instance in the network
for faster remote signal processing. Programmable gateways are thus used to relieve the load of
the central controller of a network.

GSD

The GSD file (general station description, previously “device master file”) describes the proper-
ties of the devices which are used in PROFIBUS-DP. The GSD file is a text file and is supplied in
different languages. Configuration tools require the device information in order to complete
the configuration and commissioning. The GSD file normally contains general information (e.g.
vendor name and version) and with modular devices the communication features (e.g. module
designations, texts for diagnostic messages, parameter options, parameter names).

HF

HF stands for high frequency technology and denotes the RFID applications using the frequen-
cy band around 13.56 MHz. The HF frequency band is defined by the international ISO 15693
standard.

I/0 system

An I/0 system is the collection and distribution point for digital information or analog signals
on the field level. With point-to-point wiring, the signals of the field instrumentation are col-
lected on a remote I/O station in the plant, transferred to a digital protocol and fed via a bus
cable to the controller.

IEC61131

IEC standard (International Electrotechnical Commission) 61131 is an internationally recognized
standard for programmable controllers, which specifies aspects such as the functional features,
requirements and programming language of a PLC.

Initialization (memory media)

When a memory is initialized, the memory space is reserved and filled with initial values (such
as variables, code, buffer, ...) required for the execution of tasks.
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Inlay tags

An inlay is an RFID microchip and an antenna which are attached to a foil. These RFID inlays are
further processed into a smart label for use as an RFID tag. Inlays are normally used as RFID tags
before the conversion or the respraying process.

Interface set (BL ident®)

The interface sets of the BL ident® system are fieldbus stations with a permanently defined
scope. They have a modular design and are each provided with a gateway and one of the four
RFID modules or as a compact module of the BL compact system. The interface sets are avail-
able with up to 16 channels and for the simultaneous use of up to eight read/write heads. The
gateway or compact station used depends on the fieldbus in use and the performance range of
the RFID modules.

ISO 15693

The 1SO 15693 standard is a worldwide 1SO standard which specifies the physical properties

of the RFID tag (e.g. dimensions, load, UV and X-radiation, maximum temperature), the air
interface (e.g. carrier frequency, modularization, transmission output, data rates, coding), the
initialization as well as the anti-collision protocol and the transmission protocol.

ISO 18000-6C

The ISO 18000 6C standard is compatible with EPC Global Class 1 Generation 2 (also called UHF
Gen 2) and defines the physical and logical requirements for a transmission process between a
passive tag and a read/write head in the UHF frequency band.

Item level tagging

The identification of all goods at item level with tags is known as item level tagging.

Configuring (modular fieldbus stations)

The configuration of a fieldbus station describes the systematic arrangement of the electronic
modules according to their functions within a station.

Closed-loop system

In a closed-loop RFID system, the tags fitted to a workpiece carrier, container or a pallet do not
leave the internal production process or intralogistic area of the company.

Open-loop system

In an open-loop RFID system the tags are fitted on each product (item level tagging) and leave
the company after the internal production or intralogistics process.
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Reading device
See read/write head
Read rate

The read rate is the maximum speed at which a tag is read. The read rate is defined in bits or
bytes per second.

Read distance

The read distance is the maximum distance at which a read/write head can read data from a
tag. With HF technology the read distance is virtually identical to the write distance; With UHF
technology the read distance is normally greater than the write distance.

LSB

LSB stands for "Least significant bit"; in a digital signal of a specific length, the bit that repre-
sents the lowest value.

MSB

MSB stands for "Most significant bit"; in a digital signal of a specific length, the bit that repre-
sents the highest value.

PACTware™

PACTware™ stands for “Process Automation Configuration Tool” and is an open and manufactur-
er-independent operator interface for the plant-wide operation of devices, systems and com-
munication components. The connection between the PACTware™ operator interface and the
specific device DTM is implemented via an FDT interface. PACTware™ enables the devices of an
installation to be configured and operated simply, quickly and efficiently, as well as diagnosed if
required.

PIB (Proxy Ident Block)

The Proxy Ident Function Block (PIB) is based on a specification of the PNO (PROFIBUS user
organization). In this profile manufacturers and suppliers have set communication conven-
tions between an industrial controller and an identification system. The result is a standardized
interface which guarantees interoperability between systems of different manufacturers. The
uniform communication mechanism between field device and function block in the control-
ler guarantees end-to-end data consistency. The PIB also provides a number of status bits and
commands. Besides the interoperability, the benefits are the fast implementation of the system
in the central controller, rapid project implementation and investment protection.

The BLident® modular RFID system from Turck is based on an open standard. A PIB function
block for the Siemens S7 controller series is provided as well as a function block based on
CODESYS, which can be operated, for example, in the programmable gateways of BL20/BL67
modular I/O systems.
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Polarization (RFID)

Polarization describes the alignment of an electromagnetic wave. This is either linear or circula-
tion polarization. Linearly polarized waves can be aligned vertically or horizontally depending
on the alignment of the antenna. This may be a problem for RFID systems in which tags are fas-
tened to goods as labels, as it mostly cannot be determined precisely how the antenna of the
tag is aligned to the field. The solution is the radiation of circularly polarized electromagnetic
waves. For this two antennas are arranged vertically to each other and one antenna is triggered
with a 90° out of phase signal. Polarization is either left-hand or right-hand circular polarization
(LHCP and RHCP).

Bulk detection

Bulk detection denotes the simultaneous detection (write/read) of multiple tags with a read/
write head. It must be ensured that each tag is only detected once. Possible processes for this
are, for example, the anti-collision procedure.

RFID

RFID stands for radio frequency identification, and describes the contactless or non-visual iden-
tification of objects using electromagnetic waves. For this data can be read as well as stored.

Read/write head

A read/write head transmits via radio signal data from a controller to a tag and reads the data
stored on the tag and forwards this to a controller. The core element of the Turck read/write
heads is an active antenna.

RFID/UHF read/write distances

The achievable read/write distances depend on the relevant combination of tag and read/write
head. The possible read/write distance depends on the data volume to be written and read as
well as the speed at which the tag moves past the read/write head. The UHF read/write heads
normally have a read/write distance of several meters.

Note:

The maximum read/write distance of several meters is only an idealized value under laboratory
conditions. The achievable distances may be reduced due to component tolerances, mount-
ing location in the application, ambient conditions and the influence of materials (particularly
metal and liquids). The parameters for achievable passing speed (read and write operations on
the fly) and the maximum transmittable data volume also vary depending on the actual trans-
mission in the relevant application. Depending on the tag, the maximum write distance can be
considerably less (e.g. 50%) than the maximum read distance.

A test under actual conditions is therefore always required!

All UHF read/write heads of the BL ident® system are suitable for single and multiple access to
tags.
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Write distance

The write distance denotes the maximum distance that a read/write head can bridge to store
data on a tag. With HF technology the write distance is virtually identical to the read distance;
With UHF technology the write distance is normally less than the read distance.

Type of protection

The degree of protection to IEC/EN 60529 and DIN 40050-9 defines the protection of device
housings from contact and the penetration of foreign objects and water. The most typical de-
grees of protection for TURCK devices are

IP20: protection from solid foreign bodies with @ > 50 mm; no protection from water (only

use in the switch cabinet)

IP65: full protection from dust and protection from water jets

IP67: full protection from dust and protection from water with intermittent immersion

IP69K: full protection from dust and protection from water with high pressure/steam cleaning

(Protective) ground

In electrical engineering, the name given to a conductive area with an electrical potential of
zero at any point. The electrical potential of the ground may not equal zero in the area around
grounding devices, in which case this is called the “reference ground”.

Smart label tags

Smart label tags are particularly inexpensive flat tags made of foil. The smart label tags are avail-
able in different variants, which can be stuck or printed etc., and are frequently used as dispos-
able tags.

TAG

See "Tags"

Tagging

Tagging denotes the fitting of an object with a tag.

Tracking & tracing

Tracking and tracing denotes the tracking and tracing of movable objects in intralogistics or
logistics. The process provides information on where goods are located at a specific time.
Tracking denotes the location of a specific object at a defined time.

Tracing indicates events involving the materials, semi-finished goods and end products on their
journey through the production and logistics chain.

Transponder

See "Tags"
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Turck BL ident®/UHF transmission frequencies

The Turck BL ident® system operates at nationally specified transmission frequencies in the UHF
range of (865...928 MHz) between the tags and read/write heads. UHF systems in this frequency
band achieve a higher read/write distance than HF systems, typically several meters. The na-
tional frequencies for UHF are required due to the frequency ranges individually specified by
the national regulation bodies. The BL ident® read/write heads in the UHF band can therefore
only be used in the countries they are intended for and must not be put into operation outside
of these regions.
As the BL ident® UHF tags are passive, and therefore do not radiate their own radio waves, these
are suitable for use worldwide. Turck offers different tag variants that are specially designed and
optimized for national frequency bands in order to achieve as large a communication range as
possible. Wide-band multi-range tags for international use are also available as an alternative.
The various Turck read/write heads support the following transmission frequencies:

865...868 MHz (e.g.for Europe)

902...928 MHz (e.g. for USA/Canada)

920...925 MHz (e.g. China)

902...907.5 MHz and 915...928 MHz (e.g. Brazil)

917..920.8 MHz (e.g. Korea)
The relevant national specifications for UHF such as frequency range, output and the status of
any national regulations can be obtained from the Internet at:

http://www.gs1.org/docs/epcglobal/UHF_Regulations.pdf

For more detailed information please contact the relevant authorities of the country where

you wish to use the UHF RFID system.

Transmission zone (RFID)
see Air interface
UHF

UHF stands for ultra high frequency technology and denotes the RFID applications using the
frequency bands between in the range 865...928 MHz. The requirements for the frequency
band are defined in 1ISO 18000-6C, the specification of the frequency bands is made nationally
by the relevant national authorities and is retained by the EPC.
The frequency ranges covered by Turck products are:

865...868 MHz: Europe

902...928 MHz: North and South America, except Brazil

902...907.5 MHz and 915...928 MHz: Brazil

920...925 MHz: China

917...920.8 MHz: South Korea

Wink command
A Wink command enables the identification of stations on an Ethernet network. If a gateway is

an Ethernet station and receives a Wink command, it responds with an optical signal (e.g. flash-
ing LED).
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